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In diesem Handbuch…
Dieses Handbuch enthält Anweisungen für die ersten 
Schritte, den Gebrauch, die Behebung von Problemen und 
die Wartung Ihres Agilent Microarray- Scannersystems.

1 Einführung 
In diesem Kapitel werden der Microarray- Scanner und die 
notwendigen Maßnahmen vor seinem Betrieb beschrieben.

2 Erste Schritte
In diesem Kapitel erhalten Sie Anweisungen für den sicheren 
Betrieb des Microarray- Scanners sowie für die Einrichtung 
und das Scannen von Objektträgern mit dem Agilent Scan-
Steuerungsprogramm.

3 Ändern der Scan-Einstellungen
Dieses Kapitel behandelt die Scan- Einstellungen und wann 
und wie Sie diese ändern können.

4 Verwenden der Werkzeuge 
In diesem Kapitel erfahren Sie, wie Sie Profile 
(Gruppierungen von Scan- Einstellungen), Scan- Bereiche und 
automatische Ein- /Ausschaltzeiten für den Laser einrichten.

5 Wartung und Fehlerbehebung im System
Dieses Kapitel beschreibt Wartungsverfahren und - tipps 
sowie Fehlermeldungen für die Behebung von Fehlern in 
Ihrem System. 

6 Referenz
Dieses Kapitel enthält Spezifikationen für die Objektträger 
und Informationen zur Einhaltung rechtlicher Bestimmungen.
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Dieses Kapitel enthält eine allgemeine Einführung zum
Agilent G2565CA Microarray- Scannersystem. 

Ein leistungsstarkes 
Gerät...

In diesem Abschnitt werden die leistungsstarken Funktionen 
des Microarray- Scanners beschrieben, der Lösung für 
Microarray- Analysen von Agilent. 

System- 
beschreibung

Dieser Abschnitt behandelt Hardware-  und Software-
funktionen des Microarray- Scanners, Teile-  und System-
anforderungen, Maßnahmen für die Standortvorbereitung 
und Sicherheitsrichtlinien. 

Arbeitsweise In diesem Abschnitt wird die Funktionsweise des 
Microarray- Scanners erläutert. 
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1 Einführung


Ein leistungsstarkes Gerät für Microarray-Analysen
Der Agilent Microarray- Scanner G2565CA ist eine Kompo-
nente der Lösung für Microarray- Analysen von Agilent Tech-
nologies. Der Microarray- Scanner ist ein anspruchsvoller 
Scanner, der mit laserinduziertem Fluoreszenzverfahren 
arbeitet. Er ermöglicht das Auslesen von Microarrays, die auf 
Objektträgern der Standardgröße 76 mm x 26 mm gedruckt 
sind. 

Der Microarray- Scanner misst die Fluoreszenzintensität der 
markierten Probe von der an die Microarrays gebundenen 
Nukleinsäure (DNA und RNA). Da die Fluoreszenz von zwei 
Farbstoffen gleichzeitig gemessen werden kann, erleichtert 
dies die Durchführung von zweifarbigen Microarray- Unter-
suchungen. Diese Technologie ermöglicht ein schnelles, hoch-
wertiges, automatisches Scannen von Microarrays.

Abbildung 1 Agilent Microarray-Scanner G2565CA

Jeder Objektträger wird innerhalb von Minuten ausgelesen 
und die Dateien werden für die Merkmalsanalyse vorbereitet. 
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Systembeschreibung
Dieser Abschnitt enthält Aufzählungen der Hardware-  und 
Softwarefunktionen, Teile und PC- Anforderungen sowie eine 
physische Beschreibung des Scanners und Informationen zur 
Standortvorbereitung und Sicherheit.

Hardware- und Softwarefunktionen
Der Microarray- Scanner hat folgende Funktionen: 

• Interne und externe Funktion zum Lesen von Strichcodes 

• Dynamischer Autofokus 

• Automatische Kalibrierung der PMT-Verstärkung vor jedem 
Scan-Vorgang

• Kontinuierliche Stabilisierung der Laserleistung

• 2, 3, 5 oder 10 Mikrometer Pixelgröße 

• Dynamischer Bereich von >104 für einzelne Scan-Vorgänge 
im 16- Bit- Scan- Modus, >105 für einzelne Scan- Vorgänge 
im 20- Bit- Scan- Modus und >106 für duale Scan-Vorgänge 
im 16- Bit- Scan- Modus (XDR)

• Komprimierung von TIFF- Bilddateien

• Spezifikationen zum Sicherstellen einer Gleichmäßigkeit 
von <5% VK (Variationskoeffizient)

Die Scan- Steuerungssoftware ermöglicht die Auswahl 
des Farbstoffkanals (Fluoreszenz), des Scan- Bereichs, der 
Auflösung, des dynamischen Bereichs, der PMT- Verstärkung 
und des Ausgabeordners für jeden Objektträger im Karussell. 
Diese Einstellungen können automatisch über gespeicherte 
anwendungsspezifische Profile geladen oder individuell 
ausgewählt werden.

Teileliste
Das Agilent Microarray- Scannersystem G2565CA besteht aus 
folgenden Komponenten:

• Microarray- Scanner
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1 Einführung
PC-Systemanforderungen

• Karussell und 50 Halter für Objektträger

• PC- Arbeitsplatz mit Wiederherstellungssoftware auf CD

• Stromkabel und USB- Kabel

• Scan- Steuerungssoftware 8.4 (Scan Control Software)

• Merkmalsextraktionssoftware 10.x (Feature Extraction 
Software) 

• Konformitätserklärung

Agilent Scan- Steuerungssoftware 8.4 ist für die Verwendung 
mit Agilent Merkmalsextraktionssoftware 9.5 und höher kon-
zipiert. 5-  und 10- Mikrometer- , 16- Bit- Scanvorgänge sind 
abwärtskompatibel mit FE 9.5. 2-  und 3- Mikrometer-  sowie 
alle 20- Bit- Scanvorgänge erfordern FE 10.x.

PC-Systemanforderungen
Überprüfen Sie, ob Sie über folgende für die Installation und 
Verwendung der Agilent Scan- Steuerungssoftware 
notwendigen Voraussetzungen verfügen:

Software
• Windows XP Professional mit SP2 oder Windows Vista 32 

mit SP1

• Internet Explorer 5.5 oder höher 

Hardware
• Pentium IV 3,2 GHz oder höher

• 2 GB RAM erforderlich (4 GB RAM erforderlich, falls die 
Merkmalsextraktionssoftware auf dem gleichen PC 
installiert ist)

• 250 GB verfügbarer Plattenspeicherplatz für Programme 
und Datengenerierung 
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Physische Beschreibung des Scanners
Vorderansicht des Scanners

Abbildung 2 Microarray-Scanner, Vorderansicht

Ansicht von oben auf den Scanner

Abbildung 3 Microarray-Scanner, Ansicht von oben

Abdeckung

Statusanzeige

Ein-/Aus-
Schalter

Lüftung und 
Abdeckung

Arm zum 
automatischen BeladenAbdeckung

Hinweis-
aufkleber

Karussell-
träger
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1 Einführung
Vorbereiten des Gerätestandorts

Rückansicht des Scanners

Abbildung 4 Microarray-Scanner, Rückansicht

Vorbereiten des Gerätestandorts
Stellen Sie sicher, dass in der 
Umgebung die „Microarray-
Scannerspezifikationen“ auf 
Seite 108 aus Kapitel 6 erfüllt sind. 
Wenn Sie Fragen haben, wenden 
Sie sich an Ihr Agilent Vertriebs- 
und Supportcenter oder besuchen 
Sie uns auf www.agilent.com/
chem/dnasupport.

USB-Anschluss
Lasersicherungshalter

Netzsicherungshalter

Netzspannung
Anzeigefenster

Netzspannungseinstellung

Lüftung

Netzsteckdose

Stellen Sie 
sicher, dass 
genügend Platz 
für das Öffnen 
und Schließen 
der Abdeckung 
vorhanden ist.

Stellen Sie das 
Gerät auf einen 
stabilen Labortisch.
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Sicherheitssymbole auf dem Scanner
Symbol VORSICHT
Das Produkt ist mit diesem VORSICHT- Symbol gekennzeich-
net, wenn es für den Benutzer notwendig ist, sich auf diese 
Anweisungen in der Produktdokumentation zu beziehen, 
um eine mögliche Gefahr zu erkennen. Es wird auf einen 
Betriebsablauf, ein Vorgehen o. ä. aufmerksam gemacht, die 
bei falscher Ausführung zur Beschädigung des Produkts oder 
zum Verlust wichtiger Daten führen können.

Symbol WARNUNG
Das Produkt ist mit diesem WARNUNG- Symbol gekennzeich-
net, wenn gefährliche Spannungen oder elektrische Schläge 
auftreten können. Nur geschultes Servicepersonal sollte 
Arbeiten in diesem Bereich durchführen.
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1 Einführung
Sicherheitssymbole auf dem Scanner

Sicherheitsrichtlinien
Der Agilent Microarray- Scanner G2565CA ist auf Sicherheit 
und Benutzerfreundlichkeit ausgerichtet. Lesen und beachten 
Sie vor der Inbetriebnahme des Microarray- Scanners alle 
Warnungen und Hinweise.

WARNUNG Versuchen Sie nicht, die internen Teile des Microarray-Scanners zu 
reparieren oder auf diese zuzugreifen. Andernfalls könnten Sie sich 
selbst Hochspannung und gefährlicher Laserstrahlung aussetzen. 
Das Entfernen der Abdeckungen führt dazu, dass die Garantie 
ungültig wird.

WARNUNG Der Microarray-Scanner muss an eine geerdete Steckdose 
angeschlossen werden. Eine Schutzerdung ist für die Sicherheit 
erforderlich.

VORSICHT Wenn Sie den Microarray-Scanner das erste Mal einschalten oder ihn 
an einen anderen Standort gestellt haben, müssen Sie sich vergewis-
sern, dass die Spannungswerte korrekt eingestellt sind und die Span-
nungsquelle geerdet ist. 

VORSICHT Agilent empfiehlt, den Microarray-Scanner auf einen stabilen 
Labortisch zu stellen. Der Microarray-Scanner selbst kann Vibrationen 
erzeugen und empfindlich auf externe Vibrationen reagieren.

VORSICHT Der Microarray-Scanner kann empfindlich auf kondensierende Luft-
feuchtigkeit reagieren. Befolgen Sie die in der Produktdokumentation 
genannten Sicherheitsvorkehrungen. Weitere Informationen erhalten 
Sie unter „Tipps zur Vermeidung von Problemen“ auf Seite 81 in Kapi-
tel 5 und Spezifikationen zur relativen Luftfeuchtigkeit finden Sie unter 
Seite 108 in Kapitel 6.
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Arbeitsweise
In diesem Abschnitt werden die Betriebsfunktionen des 
Agilent Microarray- Scanner G2565CA beschrieben.

Positionierung der Objektträger
Der Microarray- Scanner kann in seinem herausnehmbaren 
Karussell bis zu 48 Objektträger der Größe 76 mm x 26 mm 
aufnehmen. Während eines Karusselldurchlaufs werden die 
Objektträger nacheinander in die Position zum Scannen 
gebracht, gescannt und dann zurück in das Karussell 
befördert.

Laseranregung
Der Microarray- Scanner arbeitet mit zwei Lasern, einem 
SHG-YAG- Laser (532 nm) und einem Helium- Neon- Laser 
(633 nm). Die Laser regen mit Cyanine- 3 (Cy- 3) und 
Cyanine- 5 (Cy- 5) markierte RNA oder DNA an, um die 
Fluoreszenz nach der Hybridisierung der Zielnukleinsäure 
auf den Microarray- Sonden zu messen. Farbstoffe, die Cy- 3 
und Cy- 5 ähneln wie z.B. die Farbstoffe Alexa 647, 555 und 
660, können ebenfalls verwendet werden.

Der Microarray- Scanner wurde für einen großen Störabstand 
in den Emissionsbanden Cy- 3 (550 -  610 nm) und Cy- 5 
(650 -  750 nm) optimiert, mit einem weiten Dynamikbereich 
(bis zu fünf Zehnerpotenzen) und geringem spektralem Über-
sprechen. Dies ermöglicht die Messung von zahlreichen 
Zielkonzentrationen und sorgt für eine höhere Datenzuver-
lässigkeit bei niedrigeren Frequenzen. 

Scannen
Die Lasererregung wird schnell über das Microarray vor und 
zurück gescannt. Der dynamische Autofokus zur Nachverfol-
gung sorgt dafür, dass das Microarray immer in der Brenn-
ebene der Scan- Linse positioniert ist, um Gleichmäßigkeit 
beim Scannen sicherzustellen.
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1 Einführung
Fluoreszenzdetektion

Fluoreszenzdetektion
Die Fluoreszenz von den markierten Proben wird durch 
einen Hochleistungs- PMT in ein elektrisches Signal 
umgewandelt. Verstärker mit niedrigen Frequenzen und 
digitale Integratoren verarbeiten das PMT- Signal zu digitalen 
Messwerten, die in einer TIFF- Datei erfasst werden.

Dunkelstromsubtraktion
Bei sehr niedrigen Frequenzen können Störungen negative 
Pixelwerte erzeugen. Anstatt diese Werte auf null zu setzen, 
wodurch es zu einer fehlerhaften Messung kommen könnte, 
addiert der Agilent Scanner einen niedrigen Versatz zu allen 
Pixelwerten, sodass die gesamte Pixelverteilung erfasst 
werden kann. Dieser konstante Versatz stellt keine Störung 
dar und wird von der Agilent Merkmalsextraktionssoftware 
statistisch korrekt wieder abgezogen.
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Dieses Kapitel enthält Anweisungen für den Betrieb des 
Scanners sowie für die Einrichtung und das schnelle und 
einfache Scannen der Objektträger. 

Informationen zur Behebung von Fehlern erhalten Sie in 
Kapitel 5.
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2 Erste Schritte
Einlösen der Lizenz für hochauflösendes Scannen

Lizenzierung
Für den Agilent Scanner werden zwei 
Konfigurationsoptionen angeboten:

• die standardmäßige Konfiguration für hochauflösendes 
Scannen oder 

• ohne Hochauflösungsfunktion

Ohne die Lizenz für hochauflösendes Scannen stehen 
die Optionen 10 Mikrometer und 5 Mikrometer sowie 
5 Mikrometer für den dualen Scan-Vorgang zur Verfügung. 
Die Optionen 2 und 3 Mikrometer können nicht ausgewählt 
werden.

Falls Sie die Hochauflösungsfunktion erworben haben, benö-
tigen Sie zur Aktivierung dieser Funktion die Softwarelizenz. 
In den meisten Fällen installiert das für die Installation 
zuständige Fachpersonal die Lizenz für Sie. Ist dies nicht der 
Fall oder wird die Funktion nachträglich erworben, folgen 
Sie den unten beschriebenen Anweisungen, um die Software-
lizenz einzulösen.

Einlösen der Lizenz für hochauflösendes Scannen
Führen Sie folgende Schritte aus, um die Lizenz für 
hochauflösendes Scannen einzulösen: 

1 Halten Sie das Softwareberechtigungszertifikat griffbereit, 
das mit dem Scanner geliefert wurde.

2 Öffnen Sie die Seite https://software.business.agilent.com/
index.stm.

3 Wählen Sie die Option Click here to start software 
license redemption (Klicken Sie hier, um die 
Softwarelizenz einzulösen). 

4 Folgen Sie den Anweisungen, um Ihre Lizenz einzulösen.

https://software.business.agilent.com/index.stm
https://software.business.agilent.com/index.stm
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Installieren Ihrer Lizenz für hochauflösendes Scannen 
Wenn Sie Ihre Lizenz per E- Mail erhalten haben, führen Sie 
folgende Schritte aus, um die Lizenz zu installieren:

1 Schließen Sie das Fenster der Scan- Steuerungssoftware.

2 Suchen Sie die Lizenzdatei und verschieben Sie sie in 
folgendes Verzeichnis:

C:\Programme\Agilent\Microarray
3 Starten Sie die Scan- Steuerungssoftware neu.

Die Optionen 2 und 3 Mikrometer stehen nun zur 
Verfügung.
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Lizenz für Nicht-Agilent-Strichcodes
Falls Sie Strichcodes in einer Auflösung mit 2 oder 3 Mikro-
meter scannen müssen, die nicht von Agilent stammen, wen-
den Sie sich an Agilent, um eine spezielle Lizenz für den 
Zugriff auf diese Funktion zu erhalten. 

Ist auf einem Objektträger kein Strichcode vorhanden oder 
erkennt der Scanner den Strichcode nicht als Agilent Array 
und soll das Array mit 2-  oder 3- Mikrometerauflösung 
gescannt werden, überspringt der Scanner den Objektträger 
und gibt folgende Meldung aus, wenn diese Lizenz nicht 
erworben wurde:

„Scan settings or slide is not supported by the current scanner 
license. Contact Agilent via pdl-non_ag_barcode@agilent.com to 
obtain license to scan non-Agilent barcodes in high-resolution“. 
(Die derzeitige Scannerlizenz unterstützt die Scan-Einstellungen 
oder den Objektträger nicht. Senden Sie über pdl-non_ag_
barcode@agilent.com eine E-Mail an Agilent, um eine Lizenz zum 
Scannen von Nicht-Agilent-Strichcodes mit hoher Auflösung zu 
erhalten.)

Beziehen und Installieren einer Lizenz für Nicht-Agilent-
Strichcodes
1 Senden Sie eine E- Mail mit der Seriennummer im Textfeld 

an PDL-non_ag_barcode@agilent.com und Sie erhalten 
unmittelbar eine Lizenz. Diese Lizenz muss jedes Jahr 
erneuert werden. 

2 Wenn Sie die Lizenz erhalten haben, verschieben Sie sie in 
folgendes Verzeichnis:

C:\Programme\Agilent\Microarray
3 Schließen Sie die Scan- Steuerungssoftware und starten 

Sie sie neu.

Der Scanner erkennt die neue Lizenz.
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Inbetriebnahme des Scanners

Schritt 1. Einschalten des Agilent Microarray-Scanners
4 Schalten Sie den Microarray- Scanner über den Ein- /Aus-

Schalter an der Vorderseite des Geräts ein. Sie werden 
Folgendes bemerken:

a Ein Lüfter wird eingeschaltet und die Abdeckung wird 
verriegelt.

b Der Microarray- Scanner durchläuft eine Initialisie-
rungsroutine, die ungefähr vier Minuten dauert. Wäh-
rend der Initialisierung wird ein Selbsttest ausgeführt. 
Hierbei blinkt die Statusanzeige, da verschiedene Funk-
tionsprüfungen durchgeführt werden.

c Die Laser werden erst eingeschaltet, wenn Sie die 
Scan- Steuerungssoftware starten.

Abbildung 5 Ein-/Aus-Schalter und Statusanzeige

Weitere Informationen darüber, 
wie die Laser automatisch ein- und 
ausgeschaltet werden, erhalten 
Sie unter „Festlegen von Zeiten 
zum Ein-/Ausschalten der Laser“ 
auf Seite 72 in Kapitel 4.

5 Doppelklicken Sie auf das Symbol Agilent Scan Control, 
um das Scan- Steuerungsprogramm zu öffnen.

Oder

Klicken Sie auf Start > Programme > Agilent > Scan 
Control.

Abbildung 6 „Agilent Scan Control“ Symbol

Status-
anzeige

Ein-/Aus-
Schalter
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Wenn das Programm gestartet wird, beginnen die Laser 
mit der Aufwärmphase.

6 Prüfen Sie unten im Hauptfenster die Meldung Scanner 
status. 

Initialisieren 
des Scanners

Der Scanner wird initialisiert. Wenn die Initialisierung 
abgeschlossen ist, wird der Scannerdeckel entriegelt und 
die Laser fahren mit der Aufwärmphase fort.

Aufwärmphase 
der Laser

Die Aufwärmphase der Laser dauert etwa 30 Minuten. 
Wenn Sie auf das Aufwärmen der Laser warten müssen, 
gehen Sie zu „Schritt 2. Einlegen der Objektträger in die 
Halter“ auf Seite 26.

Laser sind 
ausgeschaltet

Wählen Sie Tools > Laser Auto ON/OFF Settings... und 
klicken Sie auf Turn Lasers ON Now, um die Laser 
einzuschalten. 

Scanner ist 
betriebsbereit

Sie können mit dem Scan-Vorgang beginnen.

Sie können einen Karusselldurchlauf nur starten, wenn beide 
Laser aufgewärmt sind. 
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Abbildung 7 Hauptfenster des Scan-Steuerungsprogramms bei 
betriebsbereiten Lasern 



26 Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) – Benutzerhandbuch

2 Erste Schritte
Schritt 1. Einschalten des Agilent Microarray-Scanners

Schritt 2. Einlegen der Objektträger in die Halter
Objektträger müssen in einen Halter eingelegt werden, bevor 
sie in das Karussell geladen werden können. Die Halter 
schützen den Objektträger während des Scan-Vorgangs. 

Abbildung 8 Einlegen der Objektträger in die Halter

Fingerabdrücke führen zu Fehlern 
bei der Fluoreszenzdetektion. 
Fassen Sie die Objektträger für 
genaue Ergebnisse nur an den 
Kanten an und arbeiten Sie bei der 
Handhabung der Objektträger 
immer mit Handschuhen. 

Beschriften Sie die Objektträger 
zudem nicht und kleben Sie keine 
anderen Etiketten außer dem 
entsprechenden Strichcode auf die 
Objektträger.

1 Halten Sie den Halter für die Objektträger mit den Seiten 
nach oben, auf denen das Agilent Logo abgebildet ist.

2 Legen Sie einen Daumen auf die Mitte der Abdeckung des 
Halters.

3 Drücken Sie die Abdeckung vorsichtig nach unten und 
schieben Sie sie in Richtung Vorderseite des Halters, bis 
sie entriegelt ist.

Weitere Informationen zum Entfernen der Objektträger 
erhalten Sie unter „Schritt 5. Entfernen der Objektträger“ auf 
Seite 37.
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Abbildung 9 Entriegeln der Abdeckung

4 Legen Sie den Objektträger in den Halter, sodass das Ende 
des Objektträgers an der Rückseite auf der Kante aufliegt.

Die aktive Microarray- Oberfläche muss nach oben zeigen.

Entriegelte Abde-
ckung des Halters für 
Objektträger
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Abbildung 10 Ordnungsgemäße Platzierung des Objektträgers an der 
Kante

5 Legen Sie den Objektträger ordnungsgemäß in den Halter:

• Das Ende ohne Strichcodeetikett liegt an der Kante an 
der Rückseite an.

• Der Objektträger liegt mit der Oberfläche nach oben, 
auf der das Microarray aufgebracht ist. Das Microarray 
wird durch das Glas gescannt.

Stellen Sie sicher, dass diese Regeln eingehalten werden, 
wenn Sie den Objektträger ausrichten.

Agilent Objektträger verfügen über zwei Strichcodes, 
einem auf jeder Seite des Glases. Siehe Abbildung 11. 
Normalerweise verfügen Nicht- Agilent- Objektträger nur 
über einen Strichcode. Platzieren Sie die Objektträgerseite 
mit dem aktiven Microarray so, dass sie nach oben in 
Richtung des Deckels des Halters zeigt. 

Weitere Informationen zum 
Anbringen eines zweiten lesbaren 
Strichcodes erhalten Sie unter 
„Spezifikationen zum Strichcode 
und Strichcodeetikett“ auf 
Seite 112.

Wenn bei einem Objektträger der Spot nicht auf der Seite 
des Objektträgers mit dem Strichcode liegt, kann der 
Scanner den Strichcode nicht lesen.

Kante des Halters

Aktive Microarray-
Oberfläche
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Abbildung 11 Beide Seiten des Objektträgers

6 Lassen Sie das andere Ende des Objektträgers los und 
lassen Sie es in den Halter fallen. 

Der Objektträger kann leicht auf den Nasen an der Seite 
des Halters aufliegen.

Abbildung 12 Objektträger fällt in den Halter

VORSICHT Ein nicht ordnungsgemäß eingelegter Objektträger kann zu 
Beschädigungen am Microarray-Scanner führen.

Nase
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7 Drücken Sie die Abdeckung des Halters vorsichtig mit 
Ihrem Daumen nach unten, um sie zu schließen. 

Abbildung 13 Schließen der Abdeckung

8 Um die Abdeckung einzurasten, schieben Sie sie vorsichtig 
mit Ihrem Daumen zurück, bis sie einrastet. 

Abbildung 14 Einrasten der Abdeckung



Erste Schritte 2
Schritt 1. Einschalten des Agilent Microarray-Scanners

Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) – Benutzerhandbuch 31

9 Prüfen Sie, dass die Abdeckung des Halters 
ordnungsgemäß eingerastet ist.

Abbildung 15 Ordnungsgemäß eingerastete Abdeckung

Unter den seitlichen 
Nasen eingerastete 
Abdeckung
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Schritt 3. Laden der Halter in das Karussell
Wenn die Objektträger ordnungsgemäß in die Halter eingelegt 
wurden, können Sie die Halter in das Karussell laden. Das 
Karussell ist so konzipiert, dass die Halter problemlos richtig 
geladen werden können. Die Halter können mit dem 
Karussell in den Scanner geladen oder aus dem Scanner 
entnommen werden.

Der Microarray-Scanner scannt die 
Objektträger in der Reihenfolge, in 
der sie erkannt werden, während 
das Karussell in die Richtung der 
Steckplätze mit aufsteigender 
Nummerierung rotiert. Im 
Karusselldurchlauf werden 
leere Steckplätze übersprungen.

1 Laden Sie einen Halter in den Karussellsteckplatz 1, den 
ersten Steckplatz im Uhrzeigersinn von der 
Ausgangsposition.

Legen Sie keinen Objektträger in den Ausgangssteckplatz. 
Der Ausgangssteckplatz ist breiter als die anderen 
Steckplätze und ist mit „Home“ beschriftet.

2 Stellen Sie sicher, dass das spitz zulaufende Ende des 
Halters auf die Mitte des Karussells zeigt. 

3 Stellen Sie sicher, dass der Halter fest im 
Karussellsteckplatz sitzt. 

Abbildung 16 Karussell

Ausgangs- 
steckplatz

Steck-
platz 1

Spitz zulau-
fende Enden 
zeigen auf die 
Mitte

VORSICHT Eine unsachgemäße Platzierung der Halter im Karussell kann zu 
schweren Beschädigungen am Microarray-Scanner führen.



Erste Schritte 2
Schritt 1. Einschalten des Agilent Microarray-Scanners

Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) – Benutzerhandbuch 33

4 Ist das Karussell bereits montiert, gehen Sie zu Schritt 5.

Ansonsten montieren Sie das Karussell.

Falls Sie die Halter in ein Karussell gesteckt haben, das 
aus dem Microarray- Scanner herausgenommen wurde, 
führen Sie folgende Schritte aus, um das Karussell wieder 
einzubauen. 

a Montieren Sie das Karussell so, dass die Ausrichtungs-
stifte auf dem Karussellträger im Microarray- Scanner in 
die Löcher im Karussell passen.

Richten Sie das das Karussell so aus, dass der D-
förmige Stab in der Mitte des Karussellträgers in das 
D- förmige Loch im Karussellboden passt, und setzen 
Sie das Karussell vorsichtig gerade nach unten in den 
Scanner ein. 

b Stellen Sie sicher, dass das Karussell fest montiert ist.

5 (Optional) Positionieren Sie den Karusselldeckel über das 
Karussell, bis die zwei seitlichen Nasen einrasten.

VORSICHT Achten Sie bei der Montage des Karussells darauf, dass Sie mit dem 
Karussell nicht gegen den Arm zum automatischen Beladen des 
Karussells stoßen. Dadurch kann es zu Ausrichtungsfehlern kommen.

VORSICHT Wenn Sie das Karussell manuell drehen müssen, machen Sie dies 
nur, wenn das Gerät ausgeschaltet ist. Andernfalls kann es zu 
Beschädigungen am Gerät kommen.
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Abbildung 17 Karusselldeckel

6 Schließen Sie die Abdeckung des Scanners.

Sie können folgende Aufgaben nicht ausführen, solange 
die Abdeckung nicht geschlossen ist:

• Den Scanner initialisieren

• Nach leeren Steckplätzen im Karussell suchen

• Strichcodes vor dem Karusselldurchlauf lesen 

• Einen Karusselldurchlauf starten

Abbildung 18 Ausrichtungsstifte und Löcher im Scanner und Karussell 

Nasen

Ausgangs-
steckplatz

Starre Ausrichtungsstifte

Bewegliche Ausrichtungsstifte

Löcher für die starren Ausrichtungsstifte

Löcher für die beweglichen Ausrichtungsstifte
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Falls eine Fehlermeldung im Karussellprotokoll erscheint, die 
auf eine Betriebsunterbrechung des Motors hinweist, kann es 
sein, dass die Ursache ein nicht ordnungsgemäß montiertes 
Karussell ist. Überprüfen Sie die Ausrichtung des Karussells 
und bauen Sie es ggf. erneut ein.
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Schritt 4. Scannen der Objektträger
Ein Scan-Vorgang bezeichnet das 

Erzeugen eines Abbilds der Proben auf 
einem einzigen Objektträger. Ein 

Karusselldurchlauf bezeichnet das 
Scannen aller gekennzeichneten 

Objektträger im Karussell.

Führen Sie die unten aufgeführten Schritte aus, um Ihre 
Objektträger für das Scannen vorzubereiten und um einen 
Karusselldurchlauf zu starten. Weitere Informationen finden 
Sie im nächsten Abschnitt, „Scannen der Objektträger“.

„Schritt 1. Festlegen der Platzierung der Steckplätze“ auf 
Seite 40

„Schritt 2. Einrichten eines Profils zum Bearbeiten aller 
Einstellungen in der Scan- Tabelle“ auf Seite 41

„Schritt 3. Ändern einzelner Scan- Einstellungen in der Scan-
Tabelle“ auf Seite 42

„Schritt 4. Starten des Karusselldurchlaufs“ auf Seite 44

„Schritt 5. Übertragen von Dateien und Archivieren von 
Daten“ auf Seite 48



Erste Schritte 2
Schritt 1. Einschalten des Agilent Microarray-Scanners

Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) – Benutzerhandbuch 37

Schritt 5. Entfernen der Objektträger
Nachdem der Karusselldurchlauf beendet ist, können Sie die 
Halter aus dem Karussell entnehmen und anschließend die 
Objektträger aus den Haltern entfernen.

1 (Optional) Nehmen Sie das Karussell aus dem Scanner.

Nehmen Sie das Karussell nicht heraus, wenn sich der 
Arm zum automatischen Beladen des Karussells über dem 
Karussell befindet. Folgen Sie stattdessen den Anwei-
sungen unter „Fehlerbehebung, wenn sich der Arm zum 
automatischen Beladen über dem Karussell befindet“ auf 
Seite 92.

2 Nehmen Sie die Halter aus dem Karussell.

3 Nehmen Sie die Objektträger aus den Haltern.

a Halten Sie den Halter für die Objektträger mit den 
Seiten nach oben, auf denen das Agilent Logo 
abgebildet ist.

b Legen Sie einen Daumen auf die Mitte der Abdeckung 
des Halters.

c Drücken Sie die Abdeckung vorsichtig nach unten und 
schieben Sie sie in Richtung Vorderseite des Halters, bis 
sie entriegelt ist.
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d Drücken Sie das Ende des Objektträgers mit dem 
Strichcode von der Unterseite des Halters nach oben, 
um Fingerabdrücke in dem Bereich mit der Probe zu 
vermeiden.

e Fassen Sie den Objektträger an den Seiten an und 
entnehmen Sie ihn aus dem Halter.

Abbildung 19 Ordnungsgemäßes Entfernen des Objektträgers

Entriegelte Abdeckung 
des Halters für Objekt-
träger

Von unten drücken
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Schritt 6. Festlegen von Zeiten für das automatische 
Ausschalten der Laser 

Sie können die Lebensdauer der Laser verlängern, indem die 
Geräte zu bestimmten Zeiten automatisch ausgeschaltet 
werden. Siehe „Festlegen von Zeiten zum Ein- /Ausschalten 
der Laser“ auf Seite 72 in Kapitel 4, „Verwenden der 
Werkzeuge“, für weitere Informationen.

Der Microarray- Scanner muss nicht ausgeschaltet werden.

Falls Sie den Scanner abschalten möchten, führen Sie 
folgende Schritte aus:

1 Klicken Sie auf Exit im Hauptfenster des Scan-
Steuerungsprogramms.

Schließen Sie das Scan- Steuerungsprogramm vor 
dem Ausschalten des Microarray- Scanners, um 
unvorhergesehene Übertragungssperren zu vermeiden.

2 Warten Sie einige Sekunden und stellen Sie sicher, dass 
die Abdeckung des Microarray- Scanners nicht verriegelt 
ist.

3 Öffnen Sie die Abdeckung.

4 Schalten Sie den Microarray- Scanner über den Ein- /Aus-
Schalter an der Vorderseite des Geräts aus.

VORSICHT Öffnen Sie die Abdeckung nur, wenn Sie gehört haben, wie diese 
entriegelt wurde. Wenn Sie versuchen, die Abdeckung während des 
Entriegelns zu öffnen, kann dies zu einem Stau im Microarray-Scanner 
führen.
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Scannen der Objektträger

Schritt 1. Festlegen der Platzierung der Steckplätze
Wenn Sie alle Objektträger in allen 48 Steckplätzen scannen 
möchten, gehen Sie zu „Schritt 2. Einrichten eines Profils 
zum Bearbeiten aller Einstellungen in der Scan- Tabelle“ auf 
Seite 41.

1 Geben Sie im Feld Start slot die Nummer des Steck-
platzes ein, der den ersten Objektträger zum Scannen 
enthält.

2 Geben Sie im Feld End Slot die Nummer des Steckplatzes 
ein, der den letzten Objektträger zum Scannen enthält.

Die Auswahl an Steckplätzen, die Sie in den Schritten 1 und 
2 eingegeben haben, wirkt sich auf die meisten Funktionen 
im Hauptfenster des Scan- Steuerungsprogramms aus. 

• Nur die Auswahl der Steckplätze, die hier eingegeben 
wird, wird in der Scan- Tabelle angezeigt.

• Der Scanner scannt nur die Objektträger der Auswahl, die 
hier eingegeben wurde.

• Mit dem Befehl Carousel Check wird nur die Auswahl 
an Steckplätzen auf leere Steckplätze und Agilent-
unterstützte Strichcodes geprüft, die hier eingegeben 
wurde. (Siehe „Prüfen auf Agilent- unterstützte Strichcodes 
und leere Steckplätze“ auf Seite 55 in Kapitel 3.)
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Schritt 2. Einrichten eines Profils zum Bearbeiten aller 
Einstellungen in der Scan-Tabelle

• Wählen Sie in der Profilliste eines der vorhandenen 
Profile aus.

Ein Profil ist eine Sammlung von Scan- 
und Bildeinstellungen, anhand derer, 
wenn sie ausgewählt sind, die Scan-

Tabelle mit Werten gefüllt wird, die im 
Profile Editor eingegeben wurden. Wenn Sie das Hauptfenster des Scan- Steuerungsprogramms 

öffnen, sehen Sie die Spalten, die mit den Werten der Scan-
Einstellungen gefüllt sind. Diese Werte werden anhand 
des letzten Profils festgelegt, das vor dem Schließen des 
Programms für einen Durchlauf ausgewählt wurde.

Agilent liefert sechs vorkonfigurierte Profile zur Auswahl 
und Verwendung mit Agilent High- Density- Microarrays, 
Agilent G3 Microarrays und Nicht- Agilent- Microarrays.

<default> Standardeinstellungen, die nach der Programminstallation 
verfügbar sind

AgilentHD_GX_2Color Agilent HD- Genexpressions- Microarrays mit 2 Farben

AgilentHD_GX_1Color Agilent HD- Genexpressions- Microarrays mit 1 Farbe

AgilentHD_CGH Agilent HD- CGH/CNV/ChIP- Microarrays

AgilentHD_miRNA Agilent HD- miRNA- Microarrays

AgilentG3_CGH Agilent G3- CGH/CNV/ChIP- Microarrays

Um alle Einstellungen in einem Schritt zu ändern, können 
Sie eines der Agilent Profile auswählen oder ein eigenes aus 
den vorhandenen Profilen erstellen (einschließlich des Profils 
<Default>). 

Weitere Informationen zum Ändern eines vorhandenen 
Profils oder Erstellen eines eigenen Profils erhalten Sie in 
Kapitel 4 unter „Bearbeiten eines vorhandenen Profils“ auf 
Seite 63 oder „Erstellen eines neuen Profils“ auf Seite 64.
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Schritt 3. Ändern einzelner Scan-Einstellungen in der Scan-
Tabelle

Wenn Sie keine Einstellungen in der über das ausgewählte 
Profil erzeugten Scan- Tabelle ändern müssen, warten Sie, 
bis die Meldung Scanner status anzeigt, dass der Scanner 
betriebsbereit ist, und fahren Sie mit „Schritt 4. Starten des 
Karusselldurchlaufs“ auf Seite 44 fort. 

1 Klicken Sie auf die Zelle(n), deren Einstellung(en) Sie 
ändern möchten.

• Klicken Sie auf eine einzelne Zelle oder

• Klicken Sie auf eine Spaltenüberschrift oder

• Markieren Sie mehrere Zellen in einer Spalte, um 
zusammenhängende Zellen auszuwählen. Rechts neben 
der ersten ausgewählten Zelle wird ein Pfeil angezeigt.

• Drücken Sie Strg und wählen Sie mehrere nicht zusam-
menhängende Zellen in einer Spalte aus. Rechts neben 
der letzten ausgewählten Zelle wird ein Pfeil angezeigt.

2 Wählen Sie aus der Liste eine neue Einstellung aus.

Die neue Einstellung wird in Fettschrift angezeigt.

HINWEIS In der Statuszeile unten im Hauptfenster des Scan-Steuerungsprogramms 
wird die geschätzte Gesamtdateigröße und Laufzeit angezeigt. Beachten 
Sie, dass genügend Speicherplatz auf dem C-Laufwerk für während des 
Scan-Vorgangs erzeugte temporäre Dateien vorhanden sein muss. Über-
schreitet die geschätzte Bildgröße zuzüglich der Dateigröße den verfüg-
baren Speicherplatz, wird der Karusselldurchlauf vom Scanner nicht 
freigegeben.
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.

VORSICHT Agilent empfiehlt, dass Sie einen Ausgabepfad zum Speichern der 
Bilddateien auf einem lokalen Laufwerk auswählen. Wenn Sie ein 
Netzwerklaufwerk für Ihren Ausgabepfad angeben und die Netzwerk-
verbindung zusammenbricht, werden die Ordner auf dem C-Laufwerk 
in der Datei Programme\Agilent\Microarray\NetDataBackup 
gespeichert.
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2 Erste Schritte
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Schritt 4. Starten des Karusselldurchlaufs
Während eines Karusselldurchlaufs werden alle ausgewählten 
Objektträger im Karussell gescannt.

1 Überprüfen Sie, ob die Meldung Scanner status im 
Hauptfenster anzeigt, dass der Scanner betriebsbereit ist.

Der Karusselldurchlauf kann nicht gestartet werden, wenn 
die Aufwärmphase der Laser noch nicht vollständig 
abgeschlossen ist.

2 Klicken Sie im Hauptfenster des Scan-
Steuerungsprogramms auf Scan Slot m- n.

Der Buchstabe m steht für den Steckplatz mit dem ersten 
Objektträger und n für den Steckplatz mit dem letzten 
Objektträger.

Zwei Vorgänge werden ausgeführt, wenn der Scan- Vorgang 
gestartet wird:

• Die Abdeckung des Scanners wird verschlossen. 

• Das Dialogfeld „Scan Progress“ wird geöffnet und zeigt 
den Status des Scan- Vorgangs an. 

Abbildung 20 Dialogfeld „Scan Progress“ 
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Die Meldungen im Fenster „Status“ des Dialogfelds „Scan 
Progress“ enthalten Informationen zum Status des Scan-
Vorgangs und Karusselldurchlaufs. 

Wenn der Karusselldurchlauf beendet ist, wird im Feld 
„Status“ die Meldung „Carousel run completed“ angezeigt. 

Das Karussellprotokoll enthält Scan-
Informationen und Meldungen zu 

Fehlern, die während des 
Karusselldurchlaufs aufgetreten sind.

Am Ende eines Karusselldurchlaufs wird automatisch das 
Karussellprotokoll angezeigt.

Abbildung 21 Karussellprotokoll

Falls Sie das letzte Karussellprotokoll öffnen möchten, 
nachdem Sie das Dialogfeld „Scan Progress“ geschlossen 
haben, finden Sie das Protokoll unter folgendem Pfad:

C:\Programme\Agilent\Microarray\Logs\CarouselRunLog.htm

Die Datei wird jedes Mal überschrieben, wenn ein neuer 
Karusselldurchlauf gestartet wird. 
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Nachdem der Durchlauf beendet ist, können Sie die 
Objektträger entnehmen. Siehe „Schritt 5. Entfernen der 
Objektträger“ auf Seite 37.

Anzeigen des Karussellprotokolls während eines Durchlaufs 
Sie können das Karussellprotokoll jederzeit während des 
Karusselldurchlaufs anzeigen. 

• Klicken Sie im Dialogfeld „Scan Progress“ auf View 
Report.

Prüfen der Daten nach dem Karusselldurchlauf oder 
währenddessen 

Weitere Informationen finden Sie 
im Schnellstarthandbuch der 
Merkmalsextraktionssoftware in 
Ihren Scannerunterlagen.

• Nachdem die Daten für einen Scan-Vorgang übertragen 
wurden, können Sie die Datei in der Agilent Merkmals-
extraktionssoftware oder einem anderen Programm anzei-
gen. 

Abbrechen eines Scan-Vorgangs
Sie können den Scan-Vorgang oder den Karusselldurchlauf 
jederzeit anhalten. 

• Klicken Sie im Dialogfeld „Scan Progress“ auf Abort. 

Folgende Meldung wird angezeigt.

Abbildung 22 Meldung über das Abbrechen eines Karusselldurchlaufs

HINWEIS Falls Sie FE 10.x auf der Festplatte eines anderen PCs installiert haben, 
müssen Sie die Bilddateien nach dem Durchlauf auf dieses Laufwerk 
übertragen. Siehe „Schritt 5. Übertragen von Dateien und Archivieren von 
Daten“ auf Seite 48.
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Es können eine oder zwei Minuten vergehen, bis der 
Microarray- Scanner den Scan-Vorgang vollständig 
abgebrochen hat, nachdem „Yes“ ausgewählt wurde. 
Gesammelte Daten werden für spätere Analysen gespeichert. 
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Schritt 5. Übertragen von Dateien und Archivieren von Daten
• Verschieben Sie die Dateien ggf. nach dem Durchlauf in 

einen anderen Ordner.

Sie haben folgende Möglichkeiten zum Speichern der Datei 
oder Dateien:

• In einem neuen Ordner im ursprünglichen Ordner auf 
dem lokalen Laufwerk, das Sie für den Ausgabepfad 
eingerichtet haben

• In einem anderen Ordner auf den lokalen Laufwerk

• In einem Ordner im Netzwerk 

Hier müssen Sie die Daten auf den PC übertragen, auf 
dem das Merkmalsextraktionsprogramm installiert ist.

• Auf CD oder DVD

Jeder PC- Arbeitsplatz ist mit einem DVD- Brenner 
ausgestattet.

VORSICHT Es ist wichtig, Daten regelmäßig vom PC des Scanners zu archivieren, 
um sicherzustellen, dass ausreichend Plattenspeicherplatz für zukünf-
tige Durchläufe verfügbar ist. Ist wenig Speicherplatz vorhanden, hält 
der Microarray-Scanner den Scan-Vorgang an und es wird ein Hinweis 
angezeigt. 
Durch regelmäßiges Defragmentieren des Festplattenlaufwerks 
können Sie die Leistung steigern.
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Bevor Sie die Objektträger scannen, können Sie die Scan-  
oder Bildeinstellungen ändern.

In diesem Kapitel werden zunächst die einzelnen 
Einstellungen der Scan- Tabelle beschrieben und dann 
erläutert, wie Sie diese einzeln oder alle in einem Schritt 
ändern können.
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3 Ändern der Scan-Einstellungen


Ändern von Einstellungen der Scan-Tabelle
Sie haben zwei Möglichkeiten, die Einstellungen der Scan-
Tabelle zu ändern:

Ein Profil ist eine Sammlung von Scan- 
und Bildeinstellungen, anhand derer, 
wenn sie ausgewählt sind, die Scan-

Tabelle mit Werten gefüllt wird, die im 
Profile Editor eingegeben wurden. 

• Ändern aller Einstellungen in einem Schritt über ein 
Profil

• Ändern einzelner Scan- Einstellungen über Dropdownlisten 
in der Scan- Tabelle

Sie können die Einträge in beliebiger Reihenfolge ändern. 
Um Zeit zu sparen, sollten Sie die Einträge in folgender 
Reihenfolge bearbeiten:

a Falls Sie Nicht- Agilent- Objektträger scannen, finden Sie 
weitere Informationen unter „Erstellen eines neuen 
Scan- Bereichs mit dem Scan Region Editor“. Ein benut-
zerdefinierter Scan- Bereich ist besser auf Ihre Objekt-
träger abgestimmt, als die in der Scan- Tabelle oder im 
Profile Editor zur Verfügung stehenden Bereiche.

b Unabhängig davon, ob Sie Agilent oder Nicht- Agilent-
Objektträger scannen, finden Sie weitere Informationen 
unter „Ändern von Einstellungen der Scan- Tabelle über 
Profile“. Hier wird ein anderes Profil ausgewählt.

c Wenn Sie ein anderes Profil ausgewählt haben 
(oder eins bearbeitet bzw. erstellt haben), finden Sie 
weitere Informationen unter „Ändern von einzelnen 
Einstellungen der Scan- Tabelle“. 

Falls Sie ein anderes Profil wählen, nachdem Sie die 
Einträge einzeln bearbeitet haben, werden geänderte 
einzelne Einträge durch die Profileinträge 
überschrieben.

d Stellen Sie sicher, dass die IDs der Objektträger 
entweder manuell oder automatisch nach der Auswahl 
des Profils erfasst werden. Für Objektträger ohne 
Strichcode ist dies obligatorisch. Für Agilent 
Objektträger ist dies optional. Siehe „Slide ID“ auf 
Seite 54.

Weitere Informationen über die Scan- Einstellungen finden 
Sie unter „Einstellungen der Scan- Tabelle“ auf Seite 54.
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Ändern von Einstellungen der Scan-Tabelle über Profile
• Wählen Sie in der Dropdownliste Profile das Profil, 

dessen Einstellungen für den Durchlauf verwendet werden 
sollen.

Abbildung 23 Dropdownliste „Profile“ im Hauptfenster des Scan-
Steuerungsprogramms 

Sie können die Einstellungen für das markierte Profil 
bearbeiten (siehe „Bearbeiten eines vorhandenen Profils“ auf 
Seite 63) oder darauf aufbauend ein neues Profil erstellen 
(siehe „Erstellen eines neuen Profils“ auf Seite 64).

Wenn Sie das Hauptfenster des Scan- Steuerungsprogramms 
öffnen, sehen Sie die Spalten, die mit den Werten der Scan-
Einstellungen gefüllt sind. Diese Werte werden anhand des 
Profils festgelegt, das zuletzt vor dem Schließen des 
Programms für einen Durchlauf gewählt wurde.

Agilent liefert sechs vorkonfigurierte Profile zur Auswahl 
und Verwendung mit Agilent High- Density- Microarrays, 
Agilent G3 Microarrays und Nicht- Agilent- Microarrays.

AgilentHD_GX_2Color Agilent HD- Genexpressions- Microarrays mit 2 Farben

AgilentHD_GX_1Color Agilent HD- Genexpressions- Microarrays mit 1 Farbe

AgilentHD_CGH Agilent HD- CGH/CNV/ChIP- Microarrays

AgilentHD_miRNA Agilent HD- miRNA- Microarrays

AgilentG3_CGH Agilent G3- CGH/CNV/ChIP- Microarrays

Für Agilent Objektträger wählen Sie das Profil, das zu Ihrem 
Agilent Microarray- Scanner passt.

Für Nicht- Agilent- Objektträger müssen Sie Änderungen an 
den einzelnen Einstellungen der Scan- Tabelle vornehmen. 
Oder Sie erstellen basierend auf dem vorhandenen Profil ein 
neues. 
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Ändern von einzelnen Einstellungen der Scan-Tabelle 
Die Scan- Tabelle ermöglicht es Ihnen, Einträge für einzelne 
Objektträger oder Objektträgergruppen zu bearbeiten. Wählen 
Sie hierzu ein Element im Dropdownmenü aus, das für jede 
Spalte außer den Spalten „Slide ID“ und „Description“ 
angezeigt wird.

1 Klicken Sie auf die Zelle(n), deren Einstellung(en) Sie 
ändern möchten.

• Klicken Sie auf eine einzelne Zelle oder

• Klicken Sie auf eine Spaltenüberschrift oder

• Markieren Sie mehrere Zellen in einer Spalte, um 
zusammenhängende Zellen auszuwählen.

Rechts neben der ersten ausgewählten Zelle wird ein 
Pfeil angezeigt.

• Drücken Sie Strg und wählen Sie mehrere nicht 
zusammenhängende Zellen in einer Spalte aus.

Rechts neben der letzten ausgewählten Zelle wird ein 
Pfeil angezeigt.

2 Klicken Sie auf den Pfeil, um die Dropdownliste 
anzuzeigen, und wählen Sie eine Einstellung.

Abbildung 24 Dropdownliste für die Einstellungen des Scan-Bereichs

Die geänderten Einstellungen werden in Fettschrift angezeigt.

Beschreibungen zu den Einstellungen dieser Spalten finden 
Sie unter „Einstellungen der Scan- Tabelle“ auf Seite 54.
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Zurücksetzen von Einstellungen der Scan-Tabelle auf aktuelle 
Profilwerte
Bei den Profilwerten, die beim Zurücksetzen angezeigt 
werden, handelt es sich um die ursprünglichen Werte des 
ausgewählten Profils. 

1 Klicken Sie auf die Zelle(n), deren Einstellung(en) Sie 
zurücksetzen möchten.

• Klicken Sie auf eine einzelne Zelle oder

• Klicken Sie auf eine Spaltenüberschrift oder

• Markieren Sie mehrere Zellen in einer Spalte, um 
zusammenhängende Zellen auszuwählen, oder

• Drücken Sie Strg und wählen Sie mehrere nicht 
zusammenhängende Zellen in einer Spalte aus oder

• Klicken Sie auf die Überschrift Slot in der oberen 
linken Ecke der Tabelle, um alle Zellen in der Scan-
Tabelle zu markieren.

2 Klicken Sie mit der rechten Maustaste auf den markierten 
Bereich und wählen Sie Reset to Profile Value.

Abbildung 25 Kontextmenü zum Zurücksetzen aller markierten 
Einstellungen auf ihre ursprünglichen Werte im aktuellen 
Profil 

Die Einstellungen im aktuellen Profil werden im markierten 
Bereich angezeigt.



54 Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) – Benutzerhandbuch

3 Ändern der Scan-Einstellungen


Einstellungen der Scan-Tabelle
In diesem Abschnitt werden die Einstellungen in der 
Scan- Tabelle beschrieben, die bearbeitet werden können. 
Anschließend wird erläutert, wie diese bearbeitet werden 
können.

Abbildung 26 Hauptfenster des Scan-Steuerungsprogramms und Scan-Tabelle mit vorkonfigurierten 
Profileinstellungen 

Slide ID Die Objektträger- ID ist eine Bezeichnung für den 
Objektträger. Die Einträge unter „Slide ID“ werden für den 
Namen der Bilddatei verwendet, falls dies im aktuellen Profil 
angegeben ist. Siehe „Naming prefix 1 und Naming prefix 2“ 
auf Seite 64.

Automatischer Eintrag Falls Ihre Objektträger über 
Strichcodes verfügen, die die Spezifikationen unter 
„Spezifikationen zum Strichcode und Strichcodeetikett“ auf 
Seite 112 erfüllen, müssen Sie die Objektträger- ID vor dem 
Karusselldurchlauf nicht in die Scan- Tabelle eingeben. Die 
Funktion „Auto detect“ in der Spalte „Slide ID“ zeigt an, 
dass der Scanner die Agilent- unterstützten Strichcodes 
automatisch beim Scannen des Objektträgers in die Scan-
Tabelle einliest. 

Sie können die Objektträger- ID auch manuell eingeben. 
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Manueller Eintrag IDs für Objektträger ohne Strichcode oder 
mit nicht unterstützten Strichcodeformaten müssen über die 
Tastatur oder ein geeignetes externes Strichcodelesegerät 
eingegeben werden.

Wenn Sie die ID über die Tastatur eingeben, doppelklicken 
Sie zunächst auf die Zelle „Slide ID“, bevor Sie den 
Strichcode oder eine eindeutige Textbezeichnung eingeben.

Prüfen auf Agilent-unterstützte Strichcodes und leere Steckplätze 
Um von Agilent unterstützte Strichcodes anzuzeigen und 
nach leeren Steckplätzen in der Spalte „Slide ID“ zu suchen, 
klicken Sie auf „Tools > Carousel Check“.

Das Programm überprüft das Karussell zunächst auf leere 
Steckplätze und schreibt für leere Steckplätze „No chip“ 
in jede Zelle unter „Slide ID“. Anschließend liest das 
Programm die Strichcodes für alle Objektträger aus und 
schreibt sie in die Zellen unter „Slide ID“.

Dye channel Mit dem Farbstoffkanal wird festgelegt, ob Informationen nur 
für rot (z.B. der Farbstoff Cy- 5), nur für grün (z.B. der 
Farbstoff Cy- 3) oder für beide Farbstoffkanäle gesammelt 
werden. Diese Auswahl hat keine Auswirkungen auf die 
Scan- Zeit. Ist allerdings nur ein Farbstoffkanal ausgewählt, 
kann sich die Dateigröße halbieren.

Scan region Der Scan- Bereich legt den zu scannenden Bereich des 
Objektträgers fest. Der Bereich sollte so groß sein, dass er 
den gesamten Druckbereich des Microarrays umfasst, aber so 
klein, dass nicht zu nah am Strichcode oder anderen nicht 
transparenten Grenzbereichen des Objektträgers gescannt 
und die Autofokus- Funktion des Scanners nicht beeinträchti-
gt wird. Eine Minimierung des Scan- Bereichs verringert 
außerdem die Scan- Zeit und spart Speicherplatz.

Agilent stellt einen Scan- Bereich zur Verfügung, der 
den Anforderungen aller Agilent High- Density-  und G3-
Objektträger entspricht, und einen weiteren, der den 
Anforderungen für Scan- Vorgänge von ganzen Objektträgern 
der Größe 76 mm x 26 mm ohne Strichcodeetikett 
entspricht.
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Für Nicht- Agilent- Objektträger müssen ggf. kundenspezifi-
sche Scan- Bereiche verwendet werden, die die Anforderun-
gen des Druckbereichs besser erfüllen. Siehe „Erstellen eines 
neuen Scan- Bereichs mit dem Scan Region Editor“ auf 
Seite 69.

Scan resolution 
(µm)

Die Scan- Auflösung (Pixelgröße) kann auf 2, 3, 5 oder 
10 Mikrometer festgelegt werden. 

Für Scan-Vorgänge mit 10 Mikrometern stellt jede Reihe von 
Pixeln im TIFF- Bild den Durchschnittswert zweier Scan-
Linien dar, eine für jede Richtung. Für Scan-Vorgänge mit 5, 
3 und 2 Mikrometern können duale Scan-Vorgänge zum 
Ermitteln dieses Durchschnittswerts gewählt werden oder 
nur eine Scan- Linie pro Bildreihe erfasst werden.

TIFF file 
dynamic range

Mit dieser Einstellung kann der dynamische Bereich auf 16 
oder 20 Bit eingestellt werden. Für den Scanner G2565CA 
wurde der dynamische Bereich des PMTs und der signalver-
arbeitenden Elektronik erweitert. Durch die Auswahl der 
Option für eine 20- Bit- TIFF- Datei erhalten Sie Zugriff auf 
diesen erweiterten Bereich. Dies ermöglicht die Quantifizie-
rung von hohen und niedrigen Frequenzen in einem einzigen 
Scan-Vorgang.

Die Scan- Steuerungssoftware ermöglicht weiterhin 
konventionelles XDR- 16- Bit- Scannen, wie nachfolgend 
beschrieben.

Die folgende Tabelle zeigt den Speicherplatz und die Scan-
Zeit für einzelne und duale Scan-Vorgänge für die jeweilig 
gewählte Auflösung an, d.h. für einen dynamischen TIFF-
Bereich mit 16 Bit oder mit 20 Bit. Der Scan- Bereich beträgt 
61 mm x 21,6 mm. 

Die Statusleiste unten im Hauptfenster des Scan- Steuerungs-
programms zeigt den geschätzten Speicherplatz und die 
geschätzte Laufzeit für den kompletten Karusselldurchlauf.
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Duale Scan- Vorgänge erfordern nicht mehr Speicherplatz als 
einzelne Scan-Vorgänge, aber dauern doppelt so lange. 

Tabelle 1 Speicherplatz und Scan-Zeit für einzelne und duale Scan-
Vorgänge für den Agilent HD-Scan-Bereich 61 mm x 21,6 mm

Auflösung Speicherplatz, 
MB, 16 Bit

Speicherplatz, 
MB, 20 Bit

Scan-Zeit, 
min.

Einzeldurchgang mit 2 
Mikrometern

1300 1600 20

Einzeldurchgang mit 3 
Mikrometern

620 760 15

Einzeldurchgang mit 5 
Mikrometern

200 300 8

Einzeldurchgang mit 10 
Mikrometern

52 115 8

Doppeldurchgang mit 2 
Mikrometern

1300 1600 40

Doppeldurchgang mit 3 
Mikrometern

620 760 30

Doppeldurchgang mit 5 
Mikrometern

200 300 16
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Red PMT Gain 
und 

Green PMT Gain

Über diese Einstellungen kann der Empfindlichkeitsgrad der 
PMTs des roten und grünen Kanals eingestellt werden. Der 
PMT ermittelt die von dem Microarray abgesonderte 
Fluoreszenz. 

Das Standardausgangssignal (100%) setzt die Verstärkung auf 
das werksseitig kalibrierte Signal; hierbei handelt es sich um 
die empfohlene Einstellung für Agilent Microarrays. Die 
jeweiligen Farbkanaleinstellungen können unabhängig davon 
auf 1% gesetzt werden.

Ist ein Microarray so hell, dass das obere Ende des Aus-
gangssignals gesättigt ist, kann die PMT- Empfindlichkeit auf 
einen Empfindlichkeitsbereich heruntergesetzt werden, 
sodass alle Informationen gelesen werden können. 

XDR Ratio Bevor der dynamische TIFF- Dateibereich mit 20- Bit zur Ver-
fügung stand, musste die XDR- Funktion „eXtended Dynamic 
Range“ für beide Scanner und die Merkmalsextraktionssoft-
ware verwendet werden, um alle gescannten Daten zwischen 
Merkmalen mit sehr niedrigen und sehr hohen Frequenzen 
zu erfassen. Nun kann als Alternative zu XDR mit dem 
dynamischen TIFF- Dateibereich mit 20- Bit gearbeitet wer-
den, um die dynamischen Daten zu erfassen.

Wenn die XDR- Funktion aktiviert ist, scannt der Scanner 
automatisch den gleichen Objektträger zweimal mit unter-
schiedlicher PMT- Empfindlichkeit. So entstehen zwei mitein-
ander verknüpfte Bilder, die bei der Merkmalsextraktion 
gleichzeitig bearbeitet werden können, um einen einheit-
lichen Satz an extrahierten Intensitätsdaten zu erhalten, die 
bis zu 6+ Zehnerpotenzen abdecken. 

Eine hohe Empfindlichkeit wird über „Red PMT Gain“ oder 
„Green PMT Gain“ festgelegt. Ist die XDR- Funktion aktiviert, 
wird sie bei Werten unter 10% automatisch deaktiviert.

Die Einstellung in der Spalte „XDR ratio“ gibt an, ob der 
Scanner einen zweiten Scan-Vorgang mit niedrigeren PMT-
Einstellungen durchführen soll oder nicht. Sind die PMTs 
für rot und grün beispielsweise auf 100% und das XDR-
Verhältnis auf 0,1 gesetzt, wird der zweite Scan-Vorgang mit 
10% für die PMTs durchgeführt. Die niedrigste verfügbare 
PMT- Einstellung beträgt 1%.
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Output path Über die Schaltfläche „Browse“ können Sie zum Speichern 
der Daten aus jedem Scan-Vorgang ein Verzeichnis auswäh-
len. Agilent empfiehlt, dass die Daten in einem lokalen Ver-
zeichnis auf einer zweiten Festplatte erfasst werden. Darüber 
hinaus können Sie auch ein Netzwerkverzeichnis auswählen. 
Wird während des Scannens ein Problem beim Netzwerkzu-
griff festgestellt, werden die Daten in einem temporären 
lokalen Verzeichnis gespeichert und ein Warnhinweis wird im 
Karussellprotokoll angezeigt.

Slide 
Description

Beschreibung der gescannten Objektträger. Diese Informatio-
nen sind in der Datei enthalten, die in der Merkmalsextrak-
tionssoftware angezeigt werden kann. 
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3 Ändern der Scan-Einstellungen

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Wenn Sie ein Profil oder einen Scan- Bereich erstellen bzw. 
bearbeiten oder Zeiten für das automatische Ausschalten der 
Laser festlegen möchten, können Sie die Werkzeuge im Menü 
„Tools“ verwenden. In diesem Kapitel wird beschrieben, wie 
Sie diese Werkzeuge verwenden:

Abbildung 27 Menü „Tools“
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4 Verwenden der Werkzeuge


Profile Editor Der Profile Editor ermöglicht es Ihnen, die Einstellungen für 
alle mit der Software gelieferten Profile zu bearbeiten: 

<Default> Das Profil, dessen Einstellungen bei der Installation sichtbar 
sind

AgilentHD_GX_2Color Agilent HD- Genexpressions- Microarrays mit 2 Farben

AgilentHD_GX_1Color Agilent HD- Genexpressions- Microarrays mit 1 Farbe

AgilentHD_CGH Agilent HD- CGH/CNV/ChIP- Microarrays

AgilentHD_miRNA Agilent HD- miRNA- Microarrays

AgilentG3_CGH Agilent G3- CGH/CNV/ChIP- Microarrays

Basierend auf den vorhandenen Profilen können auch neue 
Profile erstellt werden.

Scan Region 
Editor

Sie müssen möglicherweise Microarray- Bereiche scannen, die 
nicht standardmäßig installiert sind. Verwenden Sie den 
Scan Region Editor, um neue Bereiche zu erstellen.

Lasers Auto 
On/Off Settings

Um die Lebensdauer der Laser zu verlängern, können Sie in 
diesem Dialogfeld festlegen, dass die Laser zu bestimmten 
Zeiten automatisch ausgeschaltet werden.
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Erstellen/Bearbeiten von Profilen mit dem Profile Editor

Bearbeiten eines vorhandenen Profils
Sie können vorhandene Profile bearbeiten und speichern. Sie 
können zudem ein vorhandenes Profil bearbeiten und die 
Änderungen unter einem neuen Profilnamen speichern. 
(Siehe „Erstellen eines neuen Profils“ auf Seite 64.)

1 Wählen Sie in der Menüleiste Tools > Profile Editor  
(Abbildung 27).

Abbildung 28 Profile Editor 
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4 Verwenden der Werkzeuge
Erstellen eines neuen Profils

Beachten Sie, dass das Profil 
<default> nicht aus der Liste 
entfernt werden kann. Alle 
anderen Profile können Sie 
löschen, einschließlich der Profile, 
die Sie aus dem Profil <default> 
erstellt haben.

2 Wählen Sie ein Profil zum Bearbeiten.

3 Ändern Sie die Scan-  und Bildeinstellungen mit den in 
„Ändern von Einstellungen der Scan- Tabelle“ auf Seite 50 
und „Nicht in der Scan- Tabelle vorhandene Profileinstel-
lungen“ auf Seite 64 beschriebenen Optionen.

4 Klicken Sie auf Save.

Erstellen eines neuen Profils
Sie können aus einem beliebigen vorhandenen Profil ein 
neues Profil erstellen, indem Sie das vorhandene Profil unter 
einem neuen Namen speichern.

1 Wählen Sie Tools > Profile Editor.

2 Wählen Sie ein vorhandenes Profil aus, das Sie als neues 
Profil speichern möchten.

3 Klicken Sie auf Save As, um die vorhandene Datei unter 
einem neuen Namen zu speichern.

4 Geben Sie den Namen ein und klicken Sie auf Save.

5 Ändern Sie die Scan-  und Bildeinstellungen mit den in 
„Ändern von Einstellungen der Scan- Tabelle“ auf Seite 50 
und „Nicht in der Scan- Tabelle vorhandene Profileinstel-
lungen“ auf Seite 64 beschriebenen Optionen.

6 Klicken Sie auf Save.

Nicht in der Scan-Tabelle vorhandene Profileinstellungen
Die folgenden Einstellungen sind nicht in der Scan- Tabelle 
enthalten. Diese Parameter gelten für alle Scan- Vorgänge im 
Karusselldurchlauf.

Naming prefix 1 
und 

Naming prefix 2

Für Standard- Scan- Vorgänge wird der Dateiname im Scan-
Steuerungsprogramm aus drei Namensbestandteilen gebildet. 

Prefix1_Prefix2_ScanNumber.tif.
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Für XDR- Scan- Vorgänge wird dem Dateinamen ein 
zusätzliches Segment (_H oder _L) hinzugefügt, um XDR-
Hi- Bilder von XDR- Lo- Bildern zu unterscheiden:

Prefix1_Prefix2_ScanNumber_H.tif 
Prefix1_Prefix2_ScanNumber_L.tif

Bei der standardmäßigen Angabe für Prefix1 handelt es sich 
um die Option Instrument Serial #, Sie können aber auch Slide ID 
wählen oder ein benutzerdefiniertes Präfix verwenden.

Bei der standardmäßigen Angabe für Prefix2 handelt es sich 
um die Option Slide ID, Sie können aber auch Slot # oder Scan 
Date Time wählen oder ein benutzerdefiniertes Präfix 
verwenden. 

• Slide ID – Ist diese Option ausgewählt, wird der Eintrag 
in der Zelle „Slide ID“ für den Dateinamen verwendet. 
Steht der Eintrag <Auto detect> in der Zelle „Slide ID“, 
wird der Strichcode für den Dateinamen verwendet.

• Slot # – Die Nummer des Steckplatzes, in dem sich der 
gescannte Objektträger befindet

• Scan DateTime – Ist diese Option ausgewählt, werden 
Datum und Uhrzeit im Format YYYYMMDDHHMM 
verwendet. 

• Customize – Geben Sie ein benutzerdefiniertes Präfix 
ein, wenn Sie „Customize“ wählen (höchstens 
36 Zeichen).

Über das Scan- Steuerungsprogramm wird die Scan- Nummer 
automatisch zugewiesen. 

Das Programm vergleicht den Dateinamen eines neuen 
Scan-Vorgangs mit denen im gewählten Datenverzeichnis. 
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4 Verwenden der Werkzeuge
Nicht in der Scan-Tabelle vorhandene Profileinstellungen

Ist Prefix1_Prefix2 eindeutig, wird die Scan- Nummer auf 
S01 gesetzt.

Bei einer Übereinstimmung wird die Scan- Nummer so 
lange erhöht, bis der Dateiname eindeutig ist. 

Beispiel

US4510PP02_251485023883_S03.tif   

• Instrument Serial # = US4510PP02

• Slide ID = 251485023883

• ScanNumber = S03. Es handelt sich um die dritte Scan-
Datei im Verzeichnis mit den gleichen Angaben für 
„Instrument Serial #“ und „Slide ID“.

Compress TIFF Sie können den von den Scan- Bildern genutzten 
Speicherplatz reduzieren, indem Sie die TIFF- Dateien 
komprimieren. 

Der verwendete Komprimierunsalgorithmus, LZW, reduziert 
den Speicherplatz um 20 bis 70 Prozent. 

Split/rotate 
image

Einige Analyseprogramme benötigen Daten von um 90 Grad 
gedrehten einfarbigen Bildern. Wenn Sie die Option „Split/
Rotate“ auf „Yes“ setzen, wird die Farbdatei in zwei Farbda-
teien geteilt und die Bilder werden um 90 Grad gedreht und 
gespiegelt. 

Im Folgenden wird ein Beispielbild gezeigt:

Die geteilten Dateien haben nun die Namen FileName_green 
und FileName_red, wobei FileName für den Namen steht, 
der der Datei vor der Teilung automatisch zugewiesen 
wurde.
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Wenn Sie nur einen Farbstoffkanal für Ihre Ausgabedatei 
gewählt haben, müssen Sie diese Option auch wählen, wenn 
die Datei nur gedreht, aber nicht geteilt werden muss.

Diese Option steht nur für Scan- Vorgänge mit einem 
dynamischen 16- Bit- TIFF- Bereich zur Verfügung. 
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4 Verwenden der Werkzeuge
Starten des Scan Region Editors

Erstellen/Bearbeiten von Scan-Bereichen mit dem Scan Region 
Editor

Der Scan-Bereich legt den zu scan-
nenden Bereich des Objektträgers fest. 
Je größer der Bereich, desto länger die 

Scan-Zeit. Faktoren wie z.B. die Posi-
tionierung und Größe des Strichcode-

etiketts und Bereiche mit Mattglas 
beeinflussen den Scan-Bereich.

Falls Sie Nicht- Agilent- Objektträger verwenden, können 
Sie benutzerdefinierte Scan- Bereiche definieren oder den 
Maximalbereich von 71 mm x 21,6 mm für einen Scan-
Bereich festlegen. Der neue Bereich wird als Auswahl in 
der Scan- Tabelle und im Profile Editor angezeigt.

Starten des Scan Region Editors 
Im Hauptfenster der Scan-Steuerungssoftware
• Wählen Sie in der Menüleiste Tools > Scan Region Editor 

(Abbildung 27).

Abbildung 29 Scan Region Editor 
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Im Startmenü
• Wählen Sie in der Taskleiste Start > Programme > 

Agilent Life Sciences > Scan Region Editor.

Während der Scanner in Betrieb ist, können Sie nicht auf 
das Menüelement „Scan Region Editor“ im Hauptfenster 
zugreifen. Neue Scan- Bereiche können Sie nur über das 
Startmenü erstellen und bearbeiten. 

Erstellen eines neuen Scan-Bereichs mit dem Scan Region 
Editor

Beim Erstellen eines neuen Scan- Bereichs oder Verwenden 
von vorhandenen Scan- Bereichen müssen Sie sicherstellen, 
dass der Abstand zwischen dem Scan- Bereich und dem 
Strichcodeetikett mindestens 4 mm beträgt und dass der 
Scan- Bereich keine anderen undurchsichtigen oder 
halbtransparenten Bereiche des Objektträgers umfasst.

1 Wählen Sie in der Menüleiste des Scan Region Editors 
File > New Region.

Abbildung 30 Dialogfeld „Add New Region“

2 Geben Sie den Namen oder die Größe des Bereichs ein.

3 Geben Sie die Maße für den Bereich in mm gemäß den 
unten beschrieben Kriterien ein.
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4 Verwenden der Werkzeuge
Erstellen eines neuen Scan-Bereichs mit dem Scan Region Editor

Ungültige Werte werden rot hervorgehoben.

X X- Achsenwert für die obere linke Ecke. Sie geben diesen 
Wert und den für die Y- Achse in mm ein, um den Bereich 
auf dem Objektträger zu positionieren.

Y Y- Achsenwert für die obere linke Ecke.

Width Breite des Scan- Bereichs gemessen vom X- Achsenwert der 
oberen linken Ecke.

Height Höhe des Scan- Bereichs gemessen vom Y- Achsenwert der 
oberen linken Ecke.

Ranges Wertebereich, den Sie für jeden Wert eingeben können. 

4 Klicken Sie auf Save.

Wurden keine Fehler gefunden, öffnet sich der Scan 
Region Editor und der neue Bereich wird dort angezeigt. 

Abbildung 31 Liste der Scan-Bereiche 

Show Custom 
regions only

Ist dieses Kontrollkästchens aktiviert, werden nur die 
benutzerdefinierten Scan- Bereiche in der Liste im Scan 
Region Editor angezeigt. Ist dieses Kontrollkästchens nicht 
aktiviert, enthält die Liste auch die von Agilent bereitge-
stellten Bereiche. Diese Bereiche können jedoch nur mit 
dem Scan Region Editor bearbeitet werden.

5 Schließen Sie den Scan Region Editor.

Die neu erstellten Bereiche werden nun in den Scan-
Bereichslisten im Profile Editor und in der Scan- Tabelle 
angezeigt. 
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Bearbeiten eines vorhandenen Scan-Bereichs für Nicht-
Agilent-Objektträger

Sie können nur die von Ihnen erstellten Scan- Bereiche 
bearbeiten. Die von Agilent bereitgestellten Bereiche können 
nicht bearbeitet oder gelöscht werden.

Beim Erstellen eines neuen Scan- Bereichs oder Verwenden 
von vorhandenen Scan- Bereichen müssen Sie sicherstellen, 
dass der Abstand zwischen dem Scan- Bereich und dem 
Strichcodeetikett mindestens 4 mm beträgt.

1 Wählen Sie im Scan Region Editor den zu bearbeitenden 
Bereich aus.

2 Wählen Sie in der Menüleiste File > Open Region.

Das Dialogfeld „Modify Region“ öffnet sich.

Abbildung 32 Dialogfeld „Modify Region“

3 Ändern Sie den Namen oder die Größe des Bereichs.

4 Geben Sie die Maße für den Bereich gemäß den unter 
„Erstellen eines neuen Scan- Bereichs mit dem Scan 
Region Editor“ auf Seite 69 genannten Kriterien ein.

5 Klicken Sie auf Save.
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4 Verwenden der Werkzeuge
Aktivieren der Funktion für das automatische Ein-/Ausschalten der Laser

Festlegen von Zeiten zum Ein-/Ausschalten der Laser 
Um die Lebensdauer der Laser zu verlängern, können Sie 
festlegen, dass die Laser über das Scan- Steuerungsprogramm 
automatisch ein-  oder ausgeschaltet werden. Diese Funktion 
ermöglicht es, dass die Laser zu einem bestimmten Zeitpunkt 
bereits aufgewärmt und betriebsbereit sind oder automatisch 
zu einem bestimmten Zeitpunkt oder bei Leerlauf ausge-
schaltet werden.

Unabhängig von den Einstellungen unter „Laser Auto ON/
OFF Settings“ haben Sie folgende Möglichkeiten:

• Sie können die Laser jederzeit manuell ein-  oder 
ausschalten.

• Wenn das Scan- Steuerungsprogramm gestartet wird, 
werden die Laser eingeschaltet. 

• Wenn ein Scanner während einer definierten Ausschaltzeit 
scannt, bleiben die Laser eingeschaltet.

Aktivieren der Funktion für das automatische Ein-/
Ausschalten der Laser

1 Wählen Sie in der Menüleiste Tools > Laser Auto ON/
OFF Settings (Abbildung 27).

2 Doppelklicken Sie auf No, um die die Option Enable laser 
auto ON/OFF auf Yes zu setzen.
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Abbildung 33 Eigenschaftenseite „Laser Auto ON/OFF Settings“ 

Turn ON daily Wählen Sie Weekdays only oder Weekends und geben Sie 
die Zeit zum EINSCHALTEN der Laser unter der Woche 
oder am Wochenende ein. 

Turn OFF daily Wählen Sie Yes und geben Sie die Zeit zum 
AUSSCHALTEN der Laser unter der Woche oder am 
Wochenende ein. 

Turn OFF when idle Wählen Sie Yes und geben Sie eine Zeitspanne ein, nach 
der die inaktiven Laser automatisch ausgeschaltet werden. 
Ist die Option No gewählt, wird der Scanner bei dieser 
Bedingung nicht ausgeschaltet.

3 Klicken Sie auf OK.

HINWEIS Ist „NO“ ausgewählt, müssen Sie die Laser manuell ein- und ausschalten, 
wie im nächsten Abschnitt beschrieben.



74 Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) – Benutzerhandbuch

4 Verwenden der Werkzeuge
Manuelles Ein-/Ausschalten der Laser

Manuelles Ein-/Ausschalten der Laser
1 Öffnen Sie die Eigenschaftenseite Laser Auto ON/OFF 

Settings.

2 Klicken Sie auf Turn Lasers on Now oder Turn Lasers 
off Now.

3 Klicken Sie auf OK.
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Weitere Werkzeuge
Die folgenden zusätzlichen Werkzeuge finden Sie im Menü 
„Tools“.

Unlock Door
Mit dem Werkzeug zum Entriegeln der Tür (Tools > Unlock 
Door) können Sie versuchen, die Tür manuell zu entriegeln, 
falls das Türschloss nicht ordnungsgemäß funktioniert. 
Dies kann vorkommen, wenn die Abdeckung geöffnet wird, 
während die automatische Entriegelung des Schlosses am 
Ende eines Karusselldurchlaufs noch in Betrieb ist.

Reset Calibration Warnings
Während des normalen Betriebs kalibriert der Scanner 
G2505C die PMTs vor jedem Scan-Vorgang und die Laser 
während der Systeminitialisierung bzw. nach jedem Karus-
selldurchlauf. Ist die Kalibrierung nicht erfolgreich oder 
müssen bei der Kalibrierung erhebliche Änderungen im Ver-
gleich zum letzten Durchgang vorgenommen werden, erfasst 
die Scannersoftware dies und erzeugt Warnhinweise im 
Karussellprotokoll.

Warnhinweise zur PMT- Kalibrierung werden ausgegeben, 
wenn sich die PMT- Spannung um mehr als 20% im Vergleich 
zum letzten Kalibrierungswert ändert.

Warnhinweise zur Laserkalibrierung werden ausgegeben, 
wenn die Laser während der Aufwärmphase nicht die ange-
gebene Leistung erreichen. Ist dies der Fall, wird automa-
tisch ein Warnhinweis angezeigt und die Laser werden auf 
80% ihrer angegebenen Leistung neu kalibriert. Das Scan-
Steuerungsprogramm skaliert die TIFF- Datei so, dass die 
niedrigere Laserleistung kompensiert wird.

Sie können diese Warnhinweise zurücksetzen, indem Sie 
Tools > Reset Calibration Warnings wählen.
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Extended Laser Calibration

Ist die nächste Kalibrierung auch nicht erfolgreich und 
werden die Warnungen erneut angezeigt, sollten Sie sich an 
Ihr Agilent Vertriebs-  und Supportcenter wenden.

Extended Laser Calibration
Während der normalen Kalibrierung der Laser wird nicht 
die maximale Leistung ermittelt. Mit dem Werkzeug für eine 
erweiterte Laserkalibrierung kann eine umfangreichere Prü-
fung des Lasersubsystems durchgeführt werden. Wenn Sie 
wiederholt Warnhinweise zur Laserkalibrierung erhalten, 
kann das Agilent Supportteam Sie dazu auffordern, das 
Werkzeug für eine erweiterte Laserkalibrierung zu verwen-
den und anschließend die Log- Dateien mit den Ergebnissen 
per E- Mail zu schicken.
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Dieses Kapitel enthält Informationen zur Wartung und 
Fehlerbehebung für das Microarray- Scannersystem Agilent 
G2565CA. 
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5 Wartung und Fehlerbehebung im System
Regelmäßige Softwarewartung

Wartung Ihres Systems
Mit der richtigen Pflege und Wartung können Sie Ihren 
Microarray- Scanner ohne Komplikationen verwenden. 
Wenden Sie sich bei Fragen zur Verwendung oder Pflege 
des Microarray- Scanners an Ihr Agilent Vertriebs-  und 
Supportcenter. 

Regelmäßige 
Wartungsaufgaben

In diesen Abschnitten werden die Wartungsaufgaben für 
die Software und Hardware beschrieben, die regelmäßig 
ausgeführt werden müssen, um einen effizienten Betrieb 
des Microarray- Scanners sicherzustellen. 

Tipps zur Vermeidung 
von Problemen

In diesem Abschnitt erhalten Sie Hinweise zum Betrieb 
und zur Pflege des Microarray- Scanners, um Probleme zu 
vermeiden.

Regelmäßige Softwarewartung
Die Ausführung dieser Aufgaben trägt zur Sicherstellung 
der Leistung Ihres PC- Arbeitsplatzes und MS Windows-
Betriebssystems bei:

• Prüfen Sie mindestens einmal die Woche den 
Plattenspeicherplatz und archivieren Sie ggf. Daten.

• Löschen Sie einmal die Woche temporäre Dateien (*.mp- , 
*.tmp- Dateien) aus dem Ordner C:\Temp.

• Wenn Sie eine niedrige Leistung beobachten, defragmen-
tieren Sie die Festplatte mit der Defragmentierungssoft-
ware. 
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Regelmäßige Hardwarewartung
Die Ausführung dieser Aufgaben trägt zur Sicherstellung der 
Leistung Ihres Microarray- Scanners bei.

Überprüfen der Lüftung und des Luftfilters 
Eine hinreichende Belüftung im Microarray- Scanner ist für 
einen ordnungsgemäßen Betrieb unerlässlich. Verstopfte 
Lüftungen und dreckige Luftfilter können die Leistung 
nachhaltig beeinträchtigen.

Lüftung Lüftungen müssen einmal wöchentlich überprüft 
werden, um sicherzustellen, dass sie nicht durch Staub, 
Fremdkörper, Möbel oder sonstige Geräte blockiert werden.

Luftfilter Der Luftfilter im Microarray- Scanner sollte wie 
folgt einmal monatlich auf Schmutz geprüft werden:

1 Schalten Sie den Microarray- Scanner aus.

2 Öffnen und entfernen Sie an der rechten Seite des 
Microarray- Scanners die Luftfilterabdeckung.

Abbildung 34 Öffnen und Abnehmen der Luftfilterabdeckung

3 Entfernen Sie den Luftfilter aus dem Türgehäuse und 
führen Sie eine Sichtprüfung des Luftfilters durch.

Abnehmbare 
Luftfilter-
abdeckung
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Abbildung 35 Entfernen des Luftfilters

Reinigen des Luftfilters
Hat sich Schmutz angesammelt oder sind seit der letzten 
Reinigung sechs Monate vergangen, sollten Sie den Luftfilter 
reinigen.

1 Waschen Sie den Luftfilter mit warmem Wasser.

2 Drücken Sie das Wasser aus dem Luftfilter. 

Das Wasser sollte komplett aus dem Luftfilter 
herausgepresst werden. 

3 Lassen Sie den Luftfilter vollständig trocknen, bevor Sie 
ihn einbauen. Sie können den Filter mit Papiertüchern 
trocken tupfen.

4 Bauen Sie den Luftfilter wieder in das Gehäuse der 
Luftfilterabdeckung ein und schließen Sie die Abdeckung.

Überprüfen Sie, ob der Luftfilter nach dem Trocknen 
wieder eingesetzt wurde. Wurde der Luftfilter nicht 
wieder eingebaut, kann sich Staub im Gerät bilden und 
so die Leistung nachhaltig beeinträchtigen. 

Luftfilter (Teilenr. 3150- 0956) können direkt bei Ihrem 
Agilent Vertriebs-  und Supportcenter bestellt werden.

Luftfilterabdeckung

Luftfilter
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Tipps zur Vermeidung von Problemen
Führen Sie die zuvor beschriebenen regelmäßigen 
Wartungsaufgaben durch und befolgen Sie diese Tipps, um 
den Microarray- Scanner und seine Leistung zu warten.

Tipps zur Vermeidung von Datenverlust
• Vermeiden Sie das Laden von Softwareprogrammen, 

die eine hohe CPU- Arbeitslast erzeugen, da dies die 
Datenerfassung während des Scan-Vorgangs 
beeinträchtigen kann.

Tipps zur Vermeidung von Schäden am Scanner
• Halten Sie Flüssigkeiten und Dämpfe vom Microarray-

Scanner fern.

• Minimieren und überwachen Sie Temperatur-
schwankungen.

Setzen Sie den Microarray- Scanner nicht direkter 
Sonneneinstrahlung aus. Stellen Sie den Microarray-
Scanner nicht in der Nähe von Fenstern auf, auch wenn 
diese über Jalousien oder sonstigen Sichtschutz verfügen. 
Durch direkte Sonneneinstrahlung kann sich das Gehäuse 
des Microarray- Scanners ungleichmäßig erhitzen, wodurch 
Probleme bei der Ausrichtung der optischen Komponenten 
auftreten können.

Führen Sie Scan- Vorgänge nur aus, wenn die Labortempe-
ratur den Spezifikationen zur Betriebstemperatur für den 
Microarray- Scanner entspricht. Um eine optimale Micro-
array- Scannerleistung sicherzustellen, nehmen Sie den 
Scanner nur in Betrieb, wenn die angegebenen Tempera-
turbereiche eingehalten werden. (Siehe „Microarray- Scan-
nerspezifikationen“ auf Seite 108.)

• Überwachen Sie die Luftfeuchtigkeit.

Der Microarray- Scanner kann empfindlich auf kondensie-
rende Luftfeuchtigkeit reagieren. Um eine optimale Micro-
array- Scannerleistung sicherzustellen, nehmen Sie den 
Scanner nur in Betrieb, wenn die angegebenen Luftfeuch-
tigkeitsbereiche eingehalten werden. (Siehe „Microarray-
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Scannerspezifikationen“ auf Seite 108.) Vor dem Öffnen 
der Verpackung ist eine 10- stündige Temperaturanpassung 
vor Ort erforderlich.

Tipps zur Wartung der Hardwareleistung
• Vermeiden Sie es, den Microarray- Scanner umzustellen.

Wenn der Microarray- Scanner umgestellt werden muss, 
kann seine Leistung nachhaltig beeinträchtigt werden. 
Hilfreiche Informationen zum Umstellen des Microarray-
Scanners erhalten Sie von Ihrem Agilent Vertriebs-  und 
Supportcenter.

• Stellen Sie den Microarray- Scanner auf einen stabilen 
Labortisch.

• Vermeiden Sie es, sich auf den Microarray- Scanner zu 
stützen.

• Um die Lebensdauer der Laser zu verlängern, können 
Sie festlegen, dass die Laser automatisch ein-  und 
ausgeschaltet werden. Siehe „Festlegen von Zeiten zum 
Ein- /Ausschalten der Laser“ auf Seite 72 in Kapitel 4.

• Geben Sie dem Laser nach dem Einschalten die 
Möglichkeit zum Aufwärmen und Stabilisieren. Die 
maximale Aufwärmphase beträgt 30 Minuten. 

• Halten Sie den Karussellboden mit einem Lappen und 
ohne Lösungsmittel sauber.

• Verwenden Sie kein Aceton oder sonstige Lösungsmittel 
zum Reinigen.

• Kommen Sie nicht mit dem Getriebe beim Karussell in 
Berührung.

WARNUNG Entfernen Sie die Abdeckungen nicht. Versuchen Sie nicht, die 
internen Komponenten zu reparieren oder auf diese zuzugreifen. 
Andernfalls könnten Sie sich selbst Hochspannung und gefährlicher 
Laserstrahlung aussetzen.
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Fehlerbehebung in Ihrem System
Der Agilent Microarray- Scanner ist auf geringe Wartungs-
anforderungen und hohe Benutzerfreundlichkeit ausgerichtet. 
Wenn Sie ein Systemproblem nicht lösen können, lesen Sie 
bitte dieses Kapitel vollständig durch, bevor Sie sich an Ihr 
Agilent Vertriebs-  und Supportcenter wenden.

Technischer Support In diesem Kapitel erhalten Sie wichtige Informationen zum 
technischen Support. 

Häufig gestellte 
Fragen

Dieser Abschnitt enthält Antworten auf häufig gestellte 
Fragen zu Support und Wartung. 

Fehlerbehebung bei der 
Hardware

Hier wird die Statusanzeige beschrieben und wie Sie die 
Sicherungen austauschen. 

Fehlerbehebung 
bei der 

Software

Hier werden die Sicherheitsvorkehrungen beschrieben, 
die getroffen werden müssen, wenn Software und Daten 
auf Ihrer Festplatte mit der Wiederherstellungs- CD 
wiederhergestellt werden sollen.

Scannerfehlerm
eldungen

Hier erfahren Sie mehr über wichtige Fehlermeldungen und 
Lösungen.
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Technischer Support
Für das Agilent Microarray- Scannersystem steht technischer 
Support zur Verfügung. Lesen Sie sich das Kapitel durch, 
bevor Sie sich an Ihr Agilent Vertriebs-  und Supportcenter 
wenden. 

Technischer Support über das Internet
Über eine mit der Software gelieferte Standard- URL können 
Sie den technischen Agilent Support für den Microarray-
Scanner kontaktieren. 

• Klicken Sie auf Help > Technical Support.

Support für den PC-Arbeitsplatz
Weitere Informationen zu Problemen mit dem PC-
Arbeitsplatz finden Sie in der mit dem PC gelieferten 
Dokumentation. 

Wenn Sie das Problem dennoch nicht lösen können, wenden 
Sie sich an Ihr Agilent Vertriebs-  und Supportcenter oder 
klicken Sie auf Help > Technical Support.

Microarray-Scannersupport
Wenn Sie ein Problem mit Ihrem Microarray- Scanner haben, 
für das Unterstützung von Ihrem Agilent Vertriebs-  und 
Supportcenter erforderlich ist, können Sie dazu aufgefordert 
werden, die letzte vom Scan- Steuerungsprogramm erstellte 
Diagnose- Log- Datei bereitzustellen. Diese Dateien befinden 
sich im Ordner C:\Programme\Agilent\Microarray\Logs. 

Zusätzliche Diagnoseinformationen, einschließlich der 
Ergebnisse des Selbsttests, können mit dem HyperTerminal-
Programm erfasst werden. Weitere Informationen zum 
Einrichten und Verwenden dieses Kommunikationswerkzeugs 
erhalten Sie unter „Verwenden von HyperTerminal zur 
Erfassung von Diagnosedaten“ auf Seite 93.
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Jeder Agilent Microarray- Scanner verfügt über eine 
eindeutige 10- stellige Seriennummer. Die Seriennummer 
befindet sich auf zwei Aufklebern auf dem Microarray-
Scanner: am Karussellgestell und hinter der Filterabdeckung.

Geben Sie in der Korrespondenz mit Ihrem Agilent 
Vertriebs-  und Supportcenter immer die Modellnummer und 
10- stellige Seriennummer an. 

Notieren Sie sich die Seriennummer Ihres Agilent Microar-
ray- Scanners, die Softwareversionsnummer und das Installa-
tionsdatum in den dafür vorgesehen Feldern (wenn Sie diese 
Seite drucken) oder auf einem Blatt Papier, das Sie in der 
Nähe Ihres Scanners aufbewahren.

Scannerinformationen
Modellnr.: 

Seriennr.: 

Installationsdatum:

Softwareversionsnr.: 

Versionsnr./Datum von Softwareupdates: 

Versionsnr./Datum von Softwareupdates: 

Suche nach Versionsinformationen für die Scannersoftware 
1 Wählen Sie in der Menüleiste Help > About, um nach 

Versionsinformationen zu suchen.

2 Klicken Sie zum Schließen des Programms auf OK.
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Häufig gestellte Fragen (FAQs)
Im Folgenden werden häufig gestellte Fragen (FAQs) und 
die entsprechenden Antworten aufgeführt, die Ihnen 
beim Betrieb und der Wartung des Agilent Microarray-
Scannersystems sowie bei der Behebung von möglichen 
Fehlern als Hilfe dienen können.

Tabelle 2 FAQs 

FAQ Antwort

Ich möchte den Microarray-Scanner 
umstellen.

Die Scannerleistung könnte dadurch nachhaltig beeinträchtigt werden. 
Hilfreiche Informationen zum Umstellen und zur Sicherstellung des 
ordnungsgemäßen Betriebs des Microarray-Scanners erhalten Sie von Ihrem 
Agilent Vertriebs- und Supportcenter.

Kann ich Dateien während des 
Scannens über das Netzwerk sichern?

Agilent empfiehlt, dass Sie Ihre Datendateien direkt auf die lokale Festplatte 
speichern. Darüber hinaus können sie auf einem Netzwerkverzeichnis 
gespeichert werden. Wird während des Scannens ein Problem beim 
Netzwerkzugriff festgestellt, werden die Daten in einem temporären lokalen 
Verzeichnis gespeichert und ein Warnhinweis wird im Karussellprotokoll 
angezeigt.

Wo finde ich Supportinformationen für 
meinen PC-Arbeitsplatz, wie z.B. Treiber, 
Handbücher und Lösungen zur 
Fehlerbehebung?

Weitere Informationen zu Problemen mit dem PC-Arbeitsplatz finden Sie in der 
mit dem PC gelieferten Dokumentation. Wenn Sie das Problem dennoch nicht 
lösen können, wenden Sie sich an Ihr Agilent Vertriebs- und Supportcenter.

Ich kann die obere Abdeckung des 
Karussells nicht öffnen.

Versuchen Sie nicht, die Abdeckung mit Gewalt zu öffnen. Das gewaltsame 
Öffnen der Abdeckung kann den Microarray-Scanner beschädigen. 
1 Drücken Sie die Abdeckung nach unten, um die ggf. vorhandene 

Federspannung zu verringern, und versuchen Sie anschließend, die 
Abdeckung zu öffnen. Wenn dies nicht gelingen sollte, fahren Sie mit Schritt 
2 fort.

2 Schließen Sie das Scan-Steuerungsprogramm und starten Sie es neu.
3 Versuchen Sie, die Abdeckung zu öffnen.
4 Lässt sich die Abdeckung weiterhin nicht öffnen, schließen Sie das Scan-

Steuerungsprogramm und schalten Sie den Microarray-Scanner aus. 
Schalten Sie den Microarray-Scanner anschließend wieder ein. 

5 Versuchen Sie, die Abdeckung zu öffnen.
6 Lässt sich die Abdeckung immer noch öffnen, wenden Sie sich an Ihr Agilent 

Vertriebs- und Supportcenter.
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Das Scan-Steuerungsprogramm reagiert 
nicht.

Das Scan-Steuerungsprogramm reagiert nicht mehr – die Statusmeldung ist seit 
mehr als 15 Minuten unverändert und Sie können das Programm nicht 
schließen. Führen Sie folgende Schritte aus:
1 Öffnen Sie den Windows Task-Manager (Strg-Alt-Entf) und schließen Sie das 

Scan-Steuerungsprogramm. Starten Sie anschließend das Scan-
Steuerungsprogramm neu.

2 Schlägt dieser Schritt fehl, starten Sie den PC-Arbeitsplatz neu, schalten Sie 
den Microarray-Scanner aus und wieder ein, warten Sie, bis die gelbe 
Statusanzeige nicht mehr leuchtet, und starten Sie das Scan-
Steuerungsprogramm erneut.

Was mache ich, wenn ein Objektträger 
vom Arm zum automatischen Beladen 
des Karussells nicht ordnungsgemäß 
eingesetzt wird?

1 Drücken oder ziehen Sie (je nachdem, wobei es weniger Widerstand gibt) 
den Arm vorsichtig bis zum Ende seiner Reichweite. Üben Sie dabei keine 
Gewalt aus.

2 Schließen Sie das Scan-Steuerungsprogramm und starten Sie es neu.
3 Besteht das Problem weiterhin, wenden Sie sich an Ihr Agilent Vertriebs- 

und Supportcenter.

Der Microarray-Scanner ist 
eingeschaltet, aber die gelbe Anzeige 
leuchtet nach 20 Minuten noch.

1 Prüfen Sie, ob der PC-Arbeitsplatz eingeschaltet ist.
2 Prüfen Sie, ob das USB-Kabel mit dem PC-Arbeitsplatz und dem Microarray-

Scanner verbunden ist.
3 Wenden Sie sich an Ihr Agilent Vertriebs- und Supportcenter.

Der Microarray-Scanner ist 
eingeschaltet und das Scan-
Steuerungsprogramm ist geöffnet, 
aber der Scanner scannt nicht.

1 Schließen Sie das Scan-Steuerungsprogramm und starten Sie es neu.
Der Microarray-Scanner muss eingeschaltet sein, bevor das Scan-Steue-
rungsprogramm gestartet wird. Wenn Sie das Scan-Steuerungsprogramm 
zuerst starten, wird beim Einschalten des Scanners keine Verbindung herge-
stellt.

2 Wenden Sie sich an Ihr Agilent Vertriebs- und Supportcenter.

Tabelle 2 FAQs (Fortsetzung)

FAQ Antwort
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Fehlerbehebung bei der Hardware
Es gibt nur wenige Teile beim Microarray- Scanner, die Sie 
selbst warten können. Sie können Maßnahmen zur Behebung 
von Fehlern ergreifen, auf die durch die Statusanzeige an 
der Vorderseite hingewiesen wird. Außerdem können Sie die 
Sicherungen austauschen, die das System schützen. Bei 
anderen Problemen einschließlich Stau sollten Sie sich an 
Ihr Agilent Vertriebs-  und Supportcenter wenden.

Weitere Informationen zu Problemen mit dem PC-
Arbeitsplatz finden Sie unter „Support für den PC-
Arbeitsplatz“ auf Seite 84.

Fehlerbehebung mit der Statusanzeige
Auf der Vorderseite befinden sich drei Leuchten für die 
Statusanzeige, die den aktuellen Status des Microarray-
Scanners anzeigen. 

Abbildung 36 Statusanzeige

Tabelle 3 beschreibt die Maßnahmen, die bei der 
entsprechenden Statusanzeige durchgeführt werden müssen.

Status-
anzeige
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Tabelle 3 Anzeigestatus 

LED-Status Mögliche
Ursachen

Empfohlene
Maßnahme

Grün Gelb Rot

Aus Aus Aus Keine Stromversorgung des 
Scanners.

Überprüfen Sie Folgendes:
• Ob der Ein-/Aus-Schalter 

eingeschaltet ist
• Ob das Stromkabel 

angeschlossen ist und ob an der 
Steckdose Spannung anliegt

• dass die Sicherungen nicht 
durchgebrannt sind

Einmaliges Blinken Einmaliges 
Blinken

Einmaliges 
Blinken

LED-Test beim Einschalten 
(Dauer < 1 Sek.)

Keine Maßnahme erforderlich.

Blinken Blinken Aus Selbsttest beim Einschalten 
wird ausgeführt

Keine Maßnahme erforderlich. 
Verwenden Sie HyperTerminal, um 
Diagnoseinformationen zu 
erfassen. Siehe „Verwenden von 
HyperTerminal zur Erfassung von 
Diagnosedaten“ auf Seite 93.

Aus Blinken 
(20 Sek. aus/ 
20 Sek. an)

Aus Verbindungsversuch zum 
PC

Installieren Sie die Scan-
Steuerungssoftware 8.0, falls sie 
noch nicht installiert ist.

Aus oder an Blinken 
(Dauer = 1,3 
oder 1,0 Sek.)

Aus Herunterladen der Firmware 
und DSP-Initialisierung

Keine Maßnahme erforderlich.

An An Aus Die Laser befinden sich in 
der Aufwärmphase und sind 
noch nicht betriebsbereit.

Warten Sie. Die maximale 
Aufwärmphase beträgt 30 Minuten. 

An Aus Aus Das Gerät ist bereit für den 
Scan-Vorgang.

Keine Maßnahme erforderlich.

Blinken Aus Aus Scan-Vorgang Keine Maßnahme erforderlich.

Beliebiger Status Beliebiger 
Status

An Fehler ermittelt. Wenden Sie sich an Ihr Agilent 
Vertriebs- und Supportcenter.
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Überprüfen und Austauschen der Scannersicherungen
Der Microarray- Scanner verfügt über drei Sicherungen, zwei 
Sicherungen für das Netzteil und eine Sicherung für den 
roten Laser. Die Sicherungen befinden sich an der Rückseite 
des Microarray- Scanners. Die Sicherungen für das Netzteil 
befinden sich direkt über dem Netzstecker. Die Lasersiche-
rung befindet sich in einem runden Sicherungshalter links 
neben dem Netzstecker.

Die Sicherungen können direkt bei Agilent Technologies 
bestellt werden.

Überprüfen und Austauschen der Netzsicherungen Kann der 
Microarray- Scanner nicht eingeschaltet werden, obwohl 
Spannung an der Steckdose nachgewiesen wurde, sollten Sie 
die Sicherungen überprüfen und ggf. austauschen. Dies 
geschieht von der Rückseite des Geräts. 

1 Ziehen Sie das Stromkabel ab.

2 Heben Sie mit einem kleinen Schlitzschraubendreher die 
kleine Plastiknase an der unteren Kante des Sicherungs-
halters an, bis sie entriegelt ist.

3 Nehmen Sie den Sicherungshalter heraus und überprüfen 
Sie, ob die Sicherungen intakt sind.

4 Ist eine Sicherung durchgebrannt, tauschen Sie diese mit 
einer Sicherung vom Typ T4A, 250 V Wechselstrom aus 
(Teilenr. 2110- 1309).

5 Drücken Sie den Sicherungshalter zurück, bis er einrastet.

6 Schließen Sie das Stromkabel an.

WARNUNG Ziehen Sie das Stromkabel immer ab, bevor Sie die Sicherungen 
überprüfen oder austauschen.

VORSICHT Als Ersatz dürfen nur Sicherungen vom selben Typ oder mit gleichem 
Nennstromwert verwendet werden. Sind Sie sich bei den Sicherungen 
nicht sicher, wenden Sie sich vor dem Einbau an Ihr Agilent Vertriebs- 
und Supportcenter.
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Abbildung 37 Entfernen des Sicherungshalters für das Netzteil

Überprüfen und Austauschen der Sicherung für den roten Laser 
Kann der Microarray- Scanner eingeschaltet werden, aber 
ist der rote Laser weiterhin ausgeschaltet, können Sie die 
Lasersicherung an der Rückseite des Geräts problemlos 
überprüfen und austauschen. 

1 Ziehen Sie das Stromkabel ab.

2 Lösen Sie mit einem kleinen Schlitzschraubendreher die 
Schrauben der runden Kappe, bis sie sich abnehmen lässt.

Netzsicherungs-
halter
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Abbildung 38 Lasersicherungshalter

3 Nehmen Sie den Sicherungshalter heraus und überprüfen 
Sie, ob die Sicherungen intakt sind.

4 Ist eine Sicherung durchgebrannt, tauschen Sie diese mit 
einer Sicherung vom Typ T500mA, 250 V Wechselstrom 
aus (Teilenr. 2110- 0458).

5 Bauen Sie den Sicherungshalter wieder ein und schrauben 
Sie die Kappe an.

Fehlerbehebung, wenn sich der Arm zum automatischen Beladen 
über dem Karussell befindet
1 Schalten Sie den Scanner aus.

2 Drehen Sie das Karussell und drücken Sie den Arm in die 
richtige Position.

Sollte dies nicht funktionieren, wenden Sie sich an Ihr 
Agilent Vertriebs-  und Supportcenter.

Lasersicherungs-
halter

VORSICHT Wenn Sie das Karussell herausnehmen, während sich der Arm zum 
automatischen Beladen des Karussells über dem Karussell befindet, 
kann dies zu schweren Beschädigungen am Microarray-Scanner 
führen. 
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Verwenden von HyperTerminal zur Erfassung von 
Diagnosedaten

Durch das Einrichten einer HyperTerminal- Sitzung können 
die Agilent Servicemitarbeiter und Benutzer Daten zur 
Fehlerbehebung am Scanner erfassen. Die nachfolgenden 
Anweisungen beziehen sich auf Windows XP- Systeme. 
Anweisungen zum Erfassen von Diagnosedaten für Scanner 
mit Windows Vista 32- Systemen erhalten Sie in den Ver-
sionshinweisen zur Scan- Steuerungssoftware 8.4.

Einrichten von HyperTerminal
1 Schalten Sie den Scanner zum Starten der Initialisierung 

ein.

2 Starten Sie das Scan- Steuerungsprogramm, um die Laser 
einzuschalten.

3 Stellen Sie sicher, dass der Scanner mindestens 
30 Sekunden eingeschaltet ist, bevor Sie HyperTerminal 
starten (Schritt 4).

4 Klicken Sie auf Start > Programme > Zubehör > 
Kommunikation > HyperTerminal.

5 Im Dialogfeld „Beschreibung der Verbindung“:

a Geben Sie Scanner im Textfeld Name ein.

b Klicken Sie auf OK.
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6 Im Dialogfeld „Verbinden mit“:

a Wählen Sie in der Dropdownliste Verbindung 
herstellen über die höchste COMX- Zahl aus.

Dies ist normalerweise COM3 und kann im Windows 
Geräte- Manager geprüft werden. Der COM- Anschluss 
für den Scanner wird als „Serieller USB- Anschluss 
(COMX)“ aufgeführt.

b Klicken Sie auf OK.

7 Im Dialogfeld „Eigenschaften von COMX“:

a Wählen Sie 19200 für Bits pro Sekunde.

b Wählen Sie Kein für Flusssteuerung.

VORSICHT Während der Scanner eingeschaltet ist und HyperTerminal ausgeführt 
wird, kann der Scanner keine Initialisierung durchführen. Sie dürfen 
HyperTerminal erst 30 Sekunden nach dem Einschalten des Scanners 
starten.
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c Klicken Sie auf OK.

Das Fenster „Scanner -  HyperTerminal“ wird angezeigt.

8 Klicken Sie auf Datei > Speichern, um die Datei unter 
Scanner.ht zu speichern, und schließen Sie das Fenster.

9 Klicken Sie auf Ja, wenn Sie gefragt werden, ob Sie die 
bestehende Verbindung beenden möchten.

10 Erstellen Sie eine Verknüpfung mit dem Namen 
Scanner.ht auf dem Desktop:

a Klicken Sie auf Start > Programme > Zubehör > 
Kommunikation.

b Klicken Sie im HyperTerminal- Untermenü mit der 
rechten Maustaste auf Scanner.ht.

Beachten Sie, dass ein HyperTerminal- Untermenü im 
Menü „Kommunikation“ hinzugefügt wurde. Klicken Sie 
nicht mit der rechten Maustaste auf das HyperTerminal-
Programmsymbol im oberen Teil des Menüs.

c Klicken Sie im Kontextmenü auf Verknüpfung 
erstellen.

d Klicken Sie auf Verknüpfung mit Scanner.ht und 
ziehen Sie die Option auf den Desktop.
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11 Starten Sie eine HyperTerminal- Sitzung zum Aufzeichnen 
von Text:

a Doppelklicken Sie auf das Symbol Scanner.ht auf dem 
Desktop.

b Klicken Sie auf Übertragung > Text aufzeichnen.

c Klicken Sie auf Durchsuchen.

d Suchen Sie im Dialogfeld Datei zum Aufzeichnen 
auswählen nach dem Laufwerk E:\.

e Erstellen Sie einen neuen Ordner mit dem Namen 
Support.

f Erstellen Sie im Ordner Support einen neuen Ordner 
und nennen Sie ihn HyperTerminal Capture Files.

g Geben Sie im Ordner HyperTerminal Capture Files 
den Dateinamen Capture yymmdd-# im Textfeld 
Dateiname ein, wobei yymmdd für das heutige Datum 
und # für die Nummer der Aufzeichnungssitzung für 
diesen Tag steht.

h Klicken Sie auf Speichern.

i Klicken Sie im Dialogfeld „Text aufzeichnen“ auf 
Starten.

Die HyperTerminal- Daten werden an diese Datei angehängt, 
bis HyperTerminal geschlossen wird oder die Sitzung Text 
aufzeichnen… über das Dropdownmenü Übertragung 
beendet wird.

HyperTerminal wird geschlossen, wenn Sie sich abmelden.
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Starten einer HyperTerminal-Aufzeichnungssitzung nach 
erstmaliger Einrichtung
Sind die Laser bereits aufgewärmt, fahren Sie mit Schritt 3 
fort.

1 Schalten Sie den Scanner zum Starten der Initialisierung 
ein.

2 Starten Sie das Scan- Steuerungsprogramm, um die 
Aufwärmphase für die Laser zu starten.

3 Doppelklicken Sie auf das Desktopsymbol Scanner.ht.

4 Klicken Sie im HyperTerminal- Dropdownmenü 
Übertragung auf Text aufzeichnen.

5 Im Dialogfeld Text aufzeichnen 

a Ändern Sie den Dateinamen im Textfeld Datei, sodass 
dieser das heutige Datum und die Aufzeichnungssitzung 
enthält.

b Klicken Sie auf Starten.

Sie können auch auf „Durchsuchen“ klicken, um das Dia-
logfeld „Datei zum Aufzeichnen auswählen“ zu öffnen. 
Wählen Sie im Dialogfeld „Datei zum Aufzeichnen auswäh-
len“ einen neuen Ordner oder einen neuen Dateinamen. 
Andernfalls wird die ursprüngliche Datei der Aufzeich-
nungssitzung überschrieben. Klicken Sie anschließend auf 
Speichern, um fortzufahren.
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Fehlerbehebung bei der Software
Falls Ihr PC abstürzt oder Sie das von Agilent mit dem PC 
gelieferte Image der Festplatte neu laden möchten, finden 
Sie im Lieferumfang von Agilent eine Wiederherstellungs- CD, 
mit der Sie die Festplatte erneut abbilden können. 

Um diese CD erfolgreich zu verwenden, müssen Sie das 
USB- Kabel an der Rückseite des PCs abziehen, bevor Sie die 
CD benutzen.

VORSICHT Wenn Sie das Kabel nicht abziehen, können die Agilent Standard-
einstellungen für die USB-Geräte verändert werden und die Software 
erkennt beim Neustart der Software den Scanner nicht.



Wartung und Fehlerbehebung im System 5
Fehlerbehebung bei der Software

Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) – Benutzerhandbuch 99

Microarray-Scannerfehlermeldungen
In diesem Abschnitt wird erläutert, wie Sie mit möglichen 
Fehlermeldungen umgehen.

Quellen von Fehlermeldungen
Der PC- Monitor zeigt Fehlermeldungen für die Microarray-
Scannerhardware, die Scan- Steuerungs-  und Merkmals-
extraktionssoftware, Microsoft Windows und den PC- Arbeits-
platz an. Lesen Sie die Titelleiste der Fehlermeldung, um die 
Quelle der Fehlermeldung zu ermitteln.

Abbildung 39 Titelleiste einer Scan-Steuerungsfehlermeldung 

Hier werden die Fehlermeldungen für die Microarray-
Scannerhardware und das Scan- Steuerungsprogramm 
beschrieben.

Falls die Titelleiste anzeigt, dass ein Problem mit dem PC-
Arbeitsplatz oder Windows besteht, finden Sie weitere 
Informationen hierzu unter „Support für den PC-
Arbeitsplatz“ auf Seite 84.

Wo Scannerfehlermeldungen angezeigt werden
Fehlermeldungen können an folgenden Stellen angezeigt 
werden:

• Fehler bei der Microarray- Scannerinitialisierung werden 
in der Meldung Scanner status im Fenster des Scan-
Steuerungsprogramms angezeigt. Siehe „Schritt 4. Scannen 
der Objektträger“ auf Seite 36 in Kapitel 2.

Die Titelleiste der Fehlermeldung weist darauf hin,
dass sich diese Meldung auf die Karussellhardware 
bezieht.
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• Fehler vor dem Start des Scanners werden über 
Meldungsfelder ausgegeben.

• Einige Fehler beim Scan- Vorgang werden in der Meldung 
Status im Dialogfeld „Scan Progress“ angezeigt.

• Fehlermeldungen werden während des Karusselldurchlaufs 
im Karussellprotokoll erfasst. Siehe „Anzeigen des 
Karussellprotokolls während eines Durchlaufs“ auf 
Seite 46 in Kapitel 2. 

Wir empfehlen, dass Sie das Protokoll zumindest 
nach dem ersten Scan-Vorgang und nach Abschluss 
des Karusselldurchlaufs überprüfen. Das Protokoll wird 
automatisch am Ende eines Karusselldurchlaufs erstellt.

Fehlerbehebung bei Fehlermeldungen
Das Agilent Microarray- Scannersystem erzeugt Fehlermel-
dungen, um Sie bei der Behebung möglicher Probleme zu 
unterstützen. Viele der Fehlermeldungen bieten eine Lösung 
im Textfeld an; befolgen Sie die Anweisungen.

Die folgende Tabelle führt einige der Fehlermeldungen auf, 
die ohne Anweisungen angezeigt werden. Die Beschreibungen 
enthalten Informationen, die Ihnen bei der Lösung des 
Problems helfen können.
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Tabelle 4 Fehlermeldungen 

Fehlermeldung Beschreibung oder Lösung

Application Is Already Running Es können nicht zwei Kopien des Scan-Steuerungsprogramms gleichzeitig 
ausgeführt werden.

Autofocus error: Did not detect two 
reflective surfaces during home.

Führen Sie folgende Schritte aus:
1 Prüfen Sie, ob der Objektträger ordnungsgemäß in den Halter eingesetzt 

wurde. Siehe „Schritt 2. Einlegen der Objektträger in die Halter“ auf Seite 26 
oder versuchen Sie es mit einem anderen Objektträgerhalter.

2 Überprüfen Sie, ob der Objektträger den Agilent Spezifikationen entspricht. 
Siehe „Objektträgerspezifikationen“ auf Seite 111. 

3 Besteht das Problem für diesen Objektträger weiterhin, ist vielleicht etwas 
mit dem Objektträger nicht in Ordnung.

4 Wählen oder erzeugen Sie ggf. einen geeigneten Scan-Bereich. Bei einigen 
Nicht-Agilent-Objektträgern mit halbtransparenten oder undurchsichtigen 
Umrandungen kann es sein, dass der Scan-Bereich zu nahe am 
undurchsichtigen Bereich des Glases liegt. Siehe „Erstellen eines neuen 
Scan-Bereichs mit dem Scan Region Editor“ auf Seite 69.

5 Wenden Sie sich an Ihr Agilent Vertriebs- und Supportcenter. 

Autofocus error. No PSD signal is 
detected. Make sure there is a slide in 
the chip holder.

Führen Sie folgende Schritte aus:
1 Prüfen Sie, ob der Objektträger ordnungsgemäß in den Halter eingesetzt 

wurde. Siehe „Schritt 2. Einlegen der Objektträger in die Halter“ auf Seite 26.
2 Überprüfen Sie, ob der Objektträger den Agilent Spezifikationen entspricht. 

Siehe „Objektträgerspezifikationen“ auf Seite 111. 
3 Besteht das Problem für diesen Objektträger weiterhin, ist vielleicht etwas 

mit dem Objektträger nicht in Ordnung. 
4 Bei einigen Nicht-Agilent-Objektträgern mit halbtransparenten oder 

undurchsichtigen Umrandungen kann es sein, dass der Scan-Bereich zu 
nahe am undurchsichtigen Bereich des Glases liegt. Siehe „Erstellen eines 
neuen Scan-Bereichs mit dem Scan Region Editor“ auf Seite 69.

5 Wenden Sie sich an Ihr Agilent Vertriebs- und Supportcenter. 

Autofocus was unable to retain focus as 
it travelled to the scan start position.

Führen Sie folgende Schritte aus:
1 Stellen Sie sicher, dass der Strichcode nicht die Scan-Startposition blockiert.
2 Wählen Sie einen kleineren Scan-Bereich.
3 Besteht das Problem für diesen Objektträger weiterhin, ist vielleicht etwas 

mit dem Objektträger nicht in Ordnung. 
4 Wenden Sie sich an Ihr Agilent Vertriebs- und Supportcenter. 

Cannot eject chip. There is already a chip 
in the slot.

Führen Sie folgende Schritte aus:
1 Öffnen Sie die Scannerabdeckung.
2 Nehmen Sie den Halter aus dem Ausgangssteckplatz.
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Cannot load chip, moving the arm may be 
unsafe.

Führen Sie folgende Schritte aus:
1 Öffnen Sie die Scannerabdeckung.
2 Wenn sich der Arm zum automatischen Beladen über dem Karussell 

befindet, drücken Sie ihn vorsichtig bis zum Anschlag in den Scanner zurück.
3 Besteht das Problem weiterhin, wenden Sie sich an Ihr Agilent Vertriebs- 

und Supportcenter.

Command timed out. Führen Sie folgende Schritte aus:
1 Prüfen Sie, ob das USB-Kabel mit dem Microarray-Scanner und dem PC-

Arbeitsplatz verbunden ist. 
2 Schalten Sie den Microarray-Scanner aus und anschließend wieder ein.
3 Starten Sie das Scan-Steuerungsprogramm neu.
4 Besteht das Problem weiterhin, wenden Sie sich an Ihr Agilent Vertriebs- 

und Supportcenter.

Connection manager reports that there 
are no instruments.

Mögliche Ursachen für diesen Fehler:
• Der Microarray-Scanner ist möglicherweise nicht eingeschaltet oder Sie 

haben den Microarray-Scanner eingeschaltet, aber nicht lange genug 
gewartet, sodass der Microarray-Scanner den Selbsttest und die 
Initialisierung nicht abschließen konnte. Wählen Sie „OK“, um die Scan-
Steuerungsmeldung zu schließen, warten Sie einige Minuten und versuchen 
Sie es erneut.

• Der Microarray-Scanner ist möglicherweise nicht mit dem PC-Arbeitsplatz 
verbunden. Prüfen Sie, ob das USB-Kabel mit dem Microarray-Scanner und 
dem PC-Arbeitsplatz verbunden ist. Ist das USB-Kabel nicht angeschlossen, 
schließen Sie es erneut an, starten Sie den PC neu und schalten Sie den 
Microarray-Scanner ggf. aus und anschließend wieder ein.

• Die Internet-Protokoll-Netzwerkeigenschaften (TCP/IP) für den Scanner sind 
möglicherweise geändert worden. Überprüfen Sie, ob die IP-Adresse für die 
lokale Verbindung des Scanners 10.0.0.1 und die Subnetzmaske 
255.255.255.0 ist.

• Die Windows XP-Firewall verhindert möglicherweise die Kommunikation. 
Deaktivieren Sie die Firewall.

• Wenn Sie Ihren PC-Arbeitsplatz neu gestartet haben, müssen Sie eventuell 
den Microarray-Scanner ausschalten und anschließend wieder einschalten, 
nachdem Windows neu gestartet wurde.

Tabelle 4 Fehlermeldungen (Fortsetzung)

Fehlermeldung Beschreibung oder Lösung
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Error ejecting chip. The chip was ejected 
into the home slot.

Führen Sie folgende Schritte aus:
1 Schalten Sie den Scanner aus.
2 Öffnen Sie die Scannerabdeckung.
3 Drehen Sie das Karussell manuell, bis der Ausgangssteckplatz nicht mehr 

vom Arm zum automatischen Beladen blockiert wird.
4 Nehmen Sie den Objektträger aus dem Ausgangssteckplatz.
5 Drücken Sie den Arm vorsichtig bis zum Anschlag in den Scanner zurück.
6 Besteht das Problem weiterhin, wenden Sie sich an Ihr Agilent Vertriebs- 

und Supportcenter.

Failed to communicate with connection 
manager.

Führen Sie folgende Schritte aus:
1 Starten Sie den PC-Arbeitsplatz neu.
2 Schalten Sie den Microarray-Scanner aus und anschließend wieder ein.
3 Starten Sie das Scan-Steuerungsprogramm nach einigen Minuten neu.

Lasers never became ready. Führen Sie folgende Schritte aus:
1 Überprüfen Sie, ob die Zahl im Spannungswahlschalter auf der Rückseite des 

Scanners mit der Netzspannung übereinstimmt.
2 Wenn Sie Ihren PC-Arbeitsplatz neu gestartet haben, müssen Sie eventuell 

den Microarray-Scanner ausschalten und anschließend wieder einschalten, 
nachdem Windows neu gestartet wurde.

3 Besteht das Problem weiterhin, wenden Sie sich an Ihr Agilent Vertriebs- 
und Supportcenter.

Missing or corrupt ChipRegions.ini file. Führen Sie folgende Schritte aus:
1 Falls Sie über eine Sicherungskopie Ihrer benutzerdefinierten 

ChipRegions.ini-Datei verfügen, kopieren Sie diese in das Verzeichnis C:\
Programme\Agilent\Microarray. Mit einer Sicherungskopie von 
ChipRegions.ini können Sie den Verlust und eine erneute Erstellung 
benutzerdefinierter Scan-Bereiche vermeiden.

2 Falls Sie über keine Sicherungskopie verfügen, durchsuchen Sie den Ordner 
nach der Datei ChipRegions.bak und benennen Sie sie in ChipRegions.ini um.

3 Sind beide Dateien nicht vorhanden, installieren Sie das Scan-
Steuerungsprogramm erneut.

4 Wenden Sie sich an Ihr Agilent Vertriebs- und Supportcenter.

Tabelle 4 Fehlermeldungen (Fortsetzung)

Fehlermeldung Beschreibung oder Lösung
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Not enough disk space to create file. Auf der Festplatte ist nicht genug Speicherplatz vorhanden, um eine Datei zum 
Speichern der Scan-Daten zu erstellen. Sie können folgende Schritte ausführen:
• Navigieren Sie zum Hauptmenü des Scan-Steuerungsprogramms und wählen 

Sie ein anderes Ausgabeverzeichnis auf einer anderen Festplatte.
• Löschen oder verschieben Sie die Dateien von der aktuellen Festplatte. Siehe 

„Schritt 5. Übertragen von Dateien und Archivieren von Daten“ auf Seite 48.

PMT calibration may be unstable. Using 
last known PMT setting.

Sie können diesen Warnhinweis mit dem Werkzeug Reset Calibration 
Warnings zurücksetzen. Siehe „Weitere Werkzeuge“ auf Seite 75. Wird dieser 
Warnhinweis weiterhin oder erneut angezeigt, wenden Sie sich an Ihr Agilent 
Vertriebs- und Supportcenter.

PMT calibration lost! Using factory 
default settings.

Sie können diesen Warnhinweis mit dem Werkzeug Reset Calibration 
Warnings zurücksetzen. Siehe „Weitere Werkzeuge“ auf Seite 75. Wird dieser 
Warnhinweis weiterhin oder erneut angezeigt, wenden Sie sich an Ihr Agilent 
Vertriebs- und Supportcenter.

Slide skipped because it is outside the 
allowable thickness range or the selected 
scan region contains an obstruction to 
the initial focus positions.

Führen Sie folgende Schritte aus:
1 Überprüfen Sie, ob sich auf dem übersprungenen Objektträger ein 

Strichcode, Hybridisierungsrückstände oder andere nicht transparente 
Hindernisse befinden, die die Ausgangsposition für den Fokus blockieren. 
Die Ausgangsposition für den Fokus befindet sich 1 bis 2 mm links vom 
Scan-Bereich auf der obersten Reihe des Scan-Bereichs.

2 Messen Sie die Glasdicke und überprüfen Sie, ob sie den Spezifikationen in 
„Objektträgerspezifikationen“ auf Seite 111 entspricht.

The autoloader loading arm is in an 
unknown location. It is unclear if it is safe 
to move the carousel.

Führen Sie folgende Schritte aus:
1 Öffnen Sie die Scannerabdeckung.
2 Wenn sich der Arm zum automatischen Beladen über dem Karussell 

befindet, drücken Sie ihn vorsichtig bis zum Anschlag in den Scanner zurück.
3 Schließen Sie das Scan-Steuerungsprogramm und starten Sie es neu.
4 Besteht das Problem weiterhin, wenden Sie sich an Ihr Agilent Vertriebs- 

und Supportcenter.

The chip carousel is not present. Please 
place the carousel in the scanner and try 
again.

Setzen Sie das Karussell in den Microarray-Scanner und starten Sie den 
Karusselldurchlauf neu. Siehe „Schritt 2. Einlegen der Objektträger in die 
Halter“ auf Seite 26.

The carousel may be misaligned. Please 
remove the carousel, make sure that its 
opening is aligned with home position 
and reinsert the carousel.

Siehe „Schritt 2. Einlegen der Objektträger in die Halter“ auf Seite 26.

Tabelle 4 Fehlermeldungen (Fortsetzung)

Fehlermeldung Beschreibung oder Lösung



Wartung und Fehlerbehebung im System 5
Fehlerbehebung bei der Software

Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) – Benutzerhandbuch 105

The slide failed to eject. Pressing OK will 
re-initialize the instrument.

Wenn Sie auf „OK“ klicken, wird der Microarray-Scanner neu initialisiert. 
Schlägt dies fehl, führen Sie folgende Schritte aus:
1 Öffnen Sie die Scannerabdeckung.
2 Wenn sich der Arm zum automatischen Beladen über dem Karussell 

befindet, drücken Sie ihn vorsichtig bis zum Anschlag in den Scanner zurück. 
Wenden Sie keine Gewalt an, wenn sich der Arm nicht einfach bewegen 
lässt.

3 Schließen Sie das Scan-Steuerungsprogramm und starten Sie es neu.
4 Besteht das Problem weiterhin, wenden Sie sich an Ihr Agilent Vertriebs- 

und Supportcenter.

The software has detected a serious 
sensor error that may have existed prior 
to the installation of this version of 
software.

Wenden Sie sich an Ihr Agilent Vertriebs- und Supportcenter.

Unable to lock instrument specified by 
connection manager.

Führen Sie folgende Schritte aus:
1 Starten Sie den PC-Arbeitsplatz neu.
2 Schalten Sie den Microarray-Scanner aus und anschließend wieder ein.
3 Starten Sie das Scan-Steuerungsprogramm neu.

You must select a region to scan first. Führen Sie folgende Schritte aus, um einen Scan-Bereich in der Scan-Tabelle zu 
erfassen, der nicht im gewählten Profil enthalten ist:
1 Wählen Sie den Steckplatz bzw. die Steckplätze aus, für die Sie einen 

Bereich erfassen möchten.
2 Klicken Sie auf den Abwärtspfeil neben der Auswahl.
3 Wählen Sie aus der Liste der Scan-Bereiche einen Scan-Bereich aus. Siehe 

„Ändern von einzelnen Einstellungen der Scan-Tabelle“ auf Seite 52. 
4 Starten Sie den Scan-Vorgang oder Karusselldurchlauf. 

You must select at least one dye channel. 1 Wählen Sie den Steckplatz bzw. die Steckplätze aus, dessen Farbstoffkanal 
Sie ändern möchten.

2 Klicken Sie auf den Abwärtspfeil neben der Auswahl.
3 Wählen Sie aus der Liste eine Einstellung für den Farbstoffkanal aus. Siehe 

„Dye channel“ auf Seite 55.

Tabelle 4 Fehlermeldungen (Fortsetzung)

Fehlermeldung Beschreibung oder Lösung
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Nicht in der Tabelle aufgeführte Fehlermeldungen
Die Tabelle führt nicht alle möglichen Fehlermeldungen auf. 
Falls Ihnen eine Fehlermeldung angezeigt wird, die nicht 
aufgeführt ist, und Sie das Problem nicht beheben können, 
führen Sie folgende Schritte aus:

1 Notieren Sie sich die Fehlermeldung.

2 Starten Sie das Scan- Steuerungsprogramm neu.

3 Löst Schritt 2 das Problem nicht, führen Sie folgende 
Schritte aus:

a Starten Sie den PC- Arbeitsplatz neu.

b Schalten Sie den Microarray- Scanner aus und 
anschließend wieder ein.

c Starten Sie das Scan- Steuerungsprogramm neu.

4 Löst Schritt 3 das Problem nicht, wenden Sie sich an Ihr 
Agilent Vertriebs-  und Supportcenter.

You must close the door first. Die Initialisierung des Microarray-Scanners und Scan-Vorgänge können bei 
geöffneter Abdeckung des Microarray-Scanners nicht durchgeführt werden. 
Schließen Sie die Abdeckung.

Warning: The laser power does not fall 
within expected thresholds. Please 
contact an Agilent representative.

Warten Sie die erforderliche Aufwärmphase ab (etwa 30 Minuten), wenn die 
Statusmeldung des Scan-Steuerungsprogramms „Status Ready“ lautet. Sie 
können diesen Warnhinweis mit dem Werkzeug „Reset Calibration Warnings“ 
zurücksetzen. Siehe „Weitere Werkzeuge“ auf Seite 75. Wird dieser 
Warnhinweis weiterhin oder erneut angezeigt, wenden Sie sich an Ihr Agilent 
Vertriebs- und Supportcenter.

Das Scan-Steuerungsprogramm skaliert die TIFF-Datei so, dass die niedrigere 
Laserleistung kompensiert wird.

Tabelle 4 Fehlermeldungen (Fortsetzung)

Fehlermeldung Beschreibung oder Lösung
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Dieses Kapitel enthält Spezifikationen, Informationen zu 
rechtlichen Bestimmungen und Anweisungen zum Prüfen der 
Spannung, falls das Gerät umgestellt wird.

Microarray-
Scannerspezifikationen

In diesem Abschnitt werden die Spezifikationen für den 
Microarray- Scanner beschrieben. Weitere Informationen zu 
den Spezifikationen für den PC- Arbeitsplatz finden Sie im 
Benutzerhandbuch des PCs. 

Objektträgerspezifikationen In diesem Abschnitt werden die Spezifikationen für Glas und 
Strichcodes erläutert, die vom Scanner erkannt werden.

Informationen 
zu rechtlichen 

Bestimmungen

Dieser Abschnitt befasst sich mit den rechtlichen 
Bestimmungen zu Betriebsgeräuschen, Recycling und 
Entsorgung, elektromagnetischen Störungen sowie mit den 
Sicherheitsbestimmungen, denen der Microarray- Scanner 
entspricht.

Prüfen der 
Eingangsspannung

In diesem Abschnitt wird beschrieben, wie Sie die 
Eingangsspannung nach dem Umstellen des Geräts prüfen 
können.
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Microarray-Scannerspezifikationen
Der Microarray- Scanner hat folgende Spezifikationen: 

Ungefähre 
Maße

Höhe: 97 cm; mit geschlossener Abdeckung 55 cm

Breite: 91 cm

Tiefe: 71 cm

Diese Maße weisen die maximale Höhe und Breite bei 
offener Abdeckung und einem Abstand von 80 mm in der 
Breite für eine angemessene Belüftung aus.

Gewicht 99 kg

Stromversorgung 100, 120, 220 oder 240 V Wechselstrom bei 4 A

50/60 Hz

Sicherungen Zwei Netzsicherungen: T4A, 250 V Wechselstrom 
(Teilenr. 2110- 1309)

Eine Lasersicherung: T500mA, 250 V Wechselstrom 
(Teilenr. 2110- 0458)

Temperaturbereich Betrieb: 15° bis 30?

Lagerung: - 20° bis +50?

Feuchtigkeit Betrieb: 15% bis 95% relative Luftfeuchtigkeit bei 30°C

Kann empfindlich auf kondensierende Luftfeuchtigkeit 
reagieren. Befolgen Sie die in Kapitel 5 genannten 
Sicherheitsvorkehrungen.

Höhe Maximale Betriebshöhe: 2.300 m

Maximale Lagerungshöhe: 4.600 m

Verwendung Zur Verwendung in geschlossenen Räumen

Laser- 
informationen

Anregungswellenlängen: 

• SHG-YAG- Laser: 532 nm

• Helium- Neon- Laser (HeNe): 633 nm
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Leistung: 20 mW bei 532 nm und 23 mW bei 633 nm, beide 
geregelt auf 13 mW

Maximaler 
Scan-Bereich

Agilent G2565CA: 71 mm x 21,6 mm

Vorgeschlagener 
Microarray-

Druckbereich

1 mm kleiner als der Scan- Bereich rechts, 2 mm kleiner als 
der Scan- Bereich links und 0,6 mm kleiner als der Scan-
Bereich oben und unten. Bei Nicht- Agilent- Objektträgern ist 
der Druckbereich um die Array- Drucktoleranz kleiner als 
diese Angaben.

Unterstützte 
Farbstoffe

Cyanine- 3 (Cy- 3) und Cyanine- 5 (Cy- 5) und Farbstoffe, die 
Cy- 3 und Cy- 5 ähneln sowie die Farbstoffe Alexa 647, 555 
und 660

Auflösung 
(Pixelgröße)

2, 3, 5 oder 10 Mikrometer

Pixelpositionierungs-
fehler

< 1 Pixel bei einer Auflösung von 5 Mikrometern

Gleichmäßigkeit 5% VK für globale Ungleichmäßigkeit, die durchschnittliche 
lokale Ungleichmäßigkeit liegt normalerweise bei 1% bei 
100um- Merkmalen.

Scan-Zeit
Tabelle 5 Scan-Zeit für einzelne und duale Scan-Vorgänge für den 

Agilent HD-Scan-Bereich 61 mm x 21,6 mm

Auflösung Scan-Zeit, min.

Einzeldurchgang mit 
2 Mikrometern

20

Einzeldurchgang mit 
3 Mikrometern

15

Einzeldurchgang mit 
5 Mikrometern

8

Einzeldurchgang mit 
10 Mikrometern

8

Doppeldurchgang mit 
2 Mikrometern

40
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Dynamischer Bereich Dynamischer 16- Bit- Bereich von >104 für einzelne Scan-
Vorgänge 

Dynamischer 20- Bit- Bereich von >105 für einzelne Scan-
Vorgänge

Erweiterter dynamischer Bereich (eXtended Dynamic Range, 
XDR) von >106 für duale Scan-Vorgänge

Doppeldurchgang mit 
3 Mikrometern

30

Doppeldurchgang mit 
5 Mikrometern

16

Tabelle 5 Scan-Zeit für einzelne und duale Scan-Vorgänge für den 
Agilent HD-Scan-Bereich 61 mm x 21,6 mm

Auflösung Scan-Zeit, min.
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Objektträgerspezifikationen

Scan-Maße
Der Scan- Bereich ist in Abbildung 40 dargestellt. Alle 
Angaben sind in Millimeter und die untere rechte Glasseite 
ist der Referenzpunkt. 

Abbildung 40 Scan-Bereich für Agilent G2565CA

Glasspezifikationen
Der Microarray- Scanner verwendet Objektträgerhalter, 
um die Microarrays in das Karussell zu setzen und 
herauszunehmen. Diese Halter sind für Glasobjektträger 
der Standardgröße 76 mm x 26 mm vorgesehen. 

Die genauen Spezifikationen für das Glas lauten wie folgt:

• 25,4 mm breit, - 0,45 mm oder +0,7 mm

• 76,2 mm lang, +0,25 mm oder - 1,4 mm

• 1 mm dick (+/- 0,1 mm) 

• Keine gespiegelten Objektträger

• Hohe Qualität mit geringer Eigenfluoreszenz

• Brechungsindex von 1,510 bis 1,515
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Spezifikationen zum Strichcode und Strichcodeetikett
Strichcodespezifikationen für Agilent Objektträger
Der Scanner G2565CA liest Strichcodes, die auf der aktiven 
Seite des Objektträgers positioniert sind. 

Um eine Abwärtskompatibilität mit den Scanner der 
Serie G2565AA sicherzustellen, haben Agilent Microarrays 
weiterhin Strichcodes auf beiden Seiten. Das Etikett mit der 
Beschriftung „Agilent“ markiert die aktive Seite, das Etikett 
mit dem numerischen Wert die inaktive Seite.

Abbildung 41 Positionierung des Strichcodes für Agilent Objektträger im 
Vergleich zur Microarray-Oberfläche

Strichcodespezifikationen für Nicht-Agilent-Objektträger
• Die maximale Dicke des Strichcodeetiketts beträgt 0,2 mm. 

Stellen Sie sicher, dass das Etikett keine Blasen wirft. 
Kleben Sie keine neuen Etiketten auf alte Etiketten oder 
erneuern Sie Etiketten, die sich bereits ablösen.
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• Kleben Sie keine Strichcodeetiketten auf Objektträger, 
deren Scan- Bereich größer als 61 mm ist. Die Objekt-
träger- ID oder der Strichcode muss für Objektträger, 
deren Scan- Bereich größer als 61 mm ist, manuell ein-
gegeben werden.

• Der Abstand zwischen der Kante des Microarray- Scan-
Bereichs und des Strichcodeetiketts darf für Objektträger 
mit Strichcode nicht kleiner als 4 mm sein.

Abbildung 42 Strichcodepositionierung auf Nicht-Agilent-Objektträgern

• Die Breite des Strichcodeetiketts sollte etwa 6 mm 
betragen; die empfohlene Breite des Strichcodeetiketts 
bezieht sich auf die Verwendung mit dem 61 mm Scan-
Bereich. Größere oder längere Strichcodeetiketten können 
verwendet werden, wenn der Scan- Bereich proportional 
vergrößert wird.

• Die Strichcodeetiketten sollten so schmal sein, dass sie 
nicht gegen die Nasen der Objektträgerhalter stoßen. 

• Die maximal zulässige Neigung bei der Positionierung des 
Strichcodeetiketts auf dem Objektträger beträgt ±3°.

Der Strichcode muss folgende Anforderungen erfüllen: 

• Der leere Bereich (der Bereich zwischen der Kante des 
Etiketts und dem Anfang bzw. Ende des Strichcodes) ist 
mindestens 10 Mal so groß wie das X- Maß auf jeder Seite 
des Strichcodes.

>4 mm

Be
re

ic
h 

fü
r d

as
 

St
ric

hc
od

ee
tik

et
t

Standard-Scan-Bereich



114 Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) – Benutzerhandbuch

6 Referenz
Spezifikationen zum Strichcode und Strichcodeetikett

• Die Strichcodelinien müssen parallel zur langen Kante des 
Objektträgers mit einer Neigungstoleranz von ±3° 
ausgerichtet sein.

• Agilent bietet Unterstützung für folgende 
Strichcodeformate:

• Code 128: Nicht- Agilent- Strichcodes mit 12 Stellen 
dürfen nicht mit einer 2 beginnen

• CODABAR: maximal 8 Stellen; Mindestlinienbreite = 
0,15 mm

• Code 39: maximal 8 Stellen; Mindestlinienbreite = 
0,15 mm

• Code 93: maximal 8 Stellen; Mindestlinienbreite = 
0,15 mm

• Die Mindesthöhe des Strichcodes beträgt

• Code 128: 15% der Strichcodelänge für Code 128

• Code 39, Code 93, CODABAR: 5 mm oder 15% der 
Strichcodelänge, je nachdem, welcher Wert größer ist
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Informationen zu rechtlichen Bestimmungen
Dieser Abschnitt enthält Informationen zu den rechtlichen 
Bestimmungen für den Microarray- Scanner.

Verwendung ausschließlich für Forschungszwecke
Der Agilent Microarray- Scanner G2565CA ist 
AUSSCHLIESSLICH FÜR FORSCHUNGSZWECKE vorgesehen. 

Angaben zu Betriebsgeräuschen
Angaben des Herstellers:

English This statement is provided to comply with the 
requirements of the German Sound Emission Directive, 
from 18 January 1991. Sound Pressure Lp < 70 dB(A), at 
operator’s position, normal operation, according to EN 
27779 (Type Test).

Deutsch Die folgende Information wird in Übereinstimmung mit 
den Anforderungen der Maschinenlärminformationsverord-
nung vom 18. Januar 1991 erteilt. Schalldruckpegel am 
Arbeitsplatz bei normalem Betrieb, Lp < 70 dB(A), nach 
EN 27779 (Typprüfung).

Recycling und Entsorgung
Wenden Sie sich für weitere 
Informationen zu Recycling und 
Entsorgung an Agilent 
Technologies.

Dieses Gerät kann am Ende seiner Lebensdauer recycelt 
werden. Bitte entsorgen Sie dieses Gerät gemäß den lokalen 
Vorschriften. 

Elektromagnetische Störungen
Der Scanner ist zur Verwendung mit abgeschirmten Kabeln 
vorgesehen.

Störaussendung Erfüllt die Anforderungen zur Störaussendung für Geräte der 
Klasse A gemäß EN 61326- 1. Diese Geräte sind nicht zur 
Verwendung in Wohngebieten vorgesehen. 
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Störfestigkeit Dieses Gerät erfüllt die Anforderungen zur Störfestigkeit 
gemäß EN IEC 61326- 1 für nicht überwachte, nicht 
gewerbliche Umgebungen. Detaillierte Angaben erhalten 
Sie in der beiliegenden Konformitätserklärung. 

Canada This ISM (Industrial- Scientific- Medical) device complies with 
Canadian ICES- 001. 

Cet appareil ISM est conforme a la norme NMB- 001 du 
Canada.

Sicherheitsinformationen
Dieser Scanner erfüllt die Anforderungen folgender 
Sicherheitsstandards:

CAN/CSA-C22.2 
No. 1010.1 - 92

Safety Requirements for Electrical
Equipment for Measurement, Control, and 
Laboratory Use, Part 1: General Requirements 
(Includes Amendment 1)

CAN/CSA-C22.2 No. 
1010.1B-97 

Amendment 2 to CAN/CSA-C22.2 No.1010.1-92, 
Safety Requirements for Electrical Equipment for 
Measurement, Control, and Laboratory Use, 
Part 1: General Requirements

UL 3101.1 Electrical Equipment for Laboratory Use: 
Part 1: General Requirements

UL 3111-1 Equipment for Measurement Use; 
Part I: General Requirements

ISA S82.01-1994 Safety Standards for Electrical and Electronic 
Test, Measuring, Controlling, and Related 
Equipment - General Requirements

EN 61010-1 Sicherheitsbestimmungen für elektrische Mess-, 
Steuer-, Regel- und Laborgeräte, 
Teil 1: Allgemeine Anforderungen

EN 60825-1 Sicherheit von Lasereinrichtungen, Teil 1: 
Klassifizierung von Anlagen, Anforderungen und 
Benutzer-Richtlinien

EN60825-1
(einschließlich Änderung 1:1992 und Änderung 2:1995)
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• Verschmutzungsgrad: 2

• Installationskategorie: II

• Gerät der Klasse 1; erfordert ein Erdungssystem

• Lasereinrichtung der Klasse 1

• Einrichtung genehmigt gemäß UL/CSA
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Prüfen der Eingangsspannung

Überprüfen der Eingangsspannung
Wenn Sie den Microarray- Scanner das erste Mal einschalten 
oder ihn an einen anderen Standort gestellt haben, müssen 
Sie sich vergewissern, dass die Eingangsspannung an der 
Rückseite des Geräts korrekt eingestellt ist. Vier Werte 
können für die Eingangsspannung gewählt werden:

• 100 V Wechselstrom

• 120 V Wechselstrom

• 220 V Wechselstrom

• 240 V Wechselstrom

1 Betrachten Sie den Microarray- Scanner von der Rückseite. 

2 Die Einstellung für die Eingangsspannung wird in einem 
kleinen Fenster angezeigt.

Abbildung 43 Anzeigefenster für die Einstellung der Eingangsspannung

3 Stimmen die Einstellung für die Eingangsspannung und 
die Netzspannung überein, können Sie den Microarray-
Scanner einschalten.

Stimmen die Einstellung für die Eingangsspannung und 
die Netzspannung nicht überein, müssen Sie die 
Einstellung ändern.

Anzeigefenster 
für die Einstel-
lung der Ein-
gangsspannung
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Ändern der Spannungseinstellung
1 Ziehen Sie das Stromkabel ab.

2 Heben Sie mit einem kleinen Schlitzschraubendreher die 
kleine Plastiknase an der unteren Kante des Sicherungs-
halters an, bis sie entriegelt ist.

Abbildung 44 Entfernen des Sicherungshalters für das Netzteil

3 Nehmen Sie den Sicherungshalter heraus. 

WARNUNG Ziehen Sie das Stromkabel immer ab, bevor Sie die Einstellung für 
die Eingangsspannung ändern.

Sicherungshalter
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4 Entfernen Sie den Spannungswahlschalter mit einer 
Spitzzange.

Abbildung 45 Entfernen des Spannungswahlschalters aus dem 
Sicherungshalter

5 Positionieren Sie den Spannungswahlschalter so, dass die 
sichtbare Zahl mit der Netzspannung übereinstimmt.

6 Drücken Sie den Sicherungshalter zurück, bis er einrastet.

7 Schließen Sie das Stromkabel an.

Sicherungshalter

Spannungswahlschalter
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